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General Improvements
DaVinci Resolve 19 includes several new features using the DaVinci Neural Engine and 
Blackmagic Cloud, as well as a host of general improvements.

DaVinci Neural Engine
There have been several new features and improvements across the software that leverage 
the DaVinci Neural Engine. These features use machine learning technologies to automate and 
simplify tasks that required significant manual iteration.

IntelliTrack AI Point Tracker (Studio Version Only)
The new DaVinci Neural Engine powered IntelliTrack point tracker is now available in the Color 
tracker, Fusion point tracker, and the FX tracker in DaVinci Resolve Studio. The IntelliTrack setting 
can be used for general tracking and stabilization tasks.

IntelliTrack, like other AI tools, doesn’t use predetermined rulesets or heuristics. Instead, it is 
trained on real world examples. This makes it less likely to fail in scenarios like tracking a subject 
behind brief occlusions. For most cases it will be more precise and more robust than the normal 
point tracker.

All the IntelliTrack analysis happens behind the scenes, and there is no additional user input 
required other than to choose the IntelliTrack setting, set the tracking crosshairs over high 
contrast areas on the same moving subject, and then press one of the tracker direction controls.

Setting the IntelliTrack mode for the Color page Window Tracker

The IntelliTrack point tracker is also used to track on-screen objects for audio panning to video in 
Fairlight. This is described in greater detail in the Fairlight section.
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AI-Based UltraNR Noise Reduction for 
Spatial Denoising (Studio Version Only)
UltraNR is an AI-based noise reduction option that provides intelligently targeted noise reduction 
based on the machine learning of real world video noise patterns, rather than relying on a specific 
mathematical formula. This mode should give by far the best results for excessively noisy footage, 
as well as slightly better results with normal noise reduction. It’s designed to give an optimum 
balance between the wanted reduction of noise and the unwanted softening of the picture.

An under-exposed shot of a black dog,  
on a black blanket, on a black couch.  
The perfect storm for video noise,  
as seen above.

The same shot but with the UltraNR mode in 
the Spatial NR settings. The Show Patch icon 
has been selected, showing a white box around 
where the noise pattern is being sampled.

The UltraNR control set in the  
Color page Motion Effects pane

UltraNR is applied simply by selecting from the drop-down menu in the Mode section of 
SpatialNR. You then just need to click on the Analyze button, and UltraNR automatically analyzes 
a flat area of the image that it samples to detect Luma/Chroma noise level and sets the analysis 
Luma and Chroma sliders appropriately.

If your results need further refinement, you can use Auto to detect the flat area, and then enable 
the “Show Patch” icon. A small white outline square appears on your clip, showing you where 
the AI has placed its analysis point. You can then manually drag the patch (or also change its size 
a bit by dragging the handles) around flat areas to detect the Luma/Chroma noise level. When 
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you release the mouse button, the luma and chroma for the new box location is calculated. If the 
results are not ideal, then adjust the sliders to vary the analyzed luma and chroma a bit, adjusting 
luma first and then chroma. Once you are satisfied with the results you can hide the patch.

The new UltraNR mode for spatial denoising is available in the Color page in the Motion Effects > 
Spatial NR pane and in the Resolve FX noise reduction effect.

New Faster Option for Speed Warp (Studio Version Only)
The Speed Warp Motion Estimation mode now has a Faster setting. This will give you the 
benefits of using the DaVinci Neural Engine for fewer artifacts and higher visual quality when 
retiming a clip, but in a faster timeframe. The original Speed Warp setting has been renamed 
Speed Warp Better and should still provide the best output.

Option to Detect Speakers for Text-Based 
Editing Workflows (Studio Version Only)
DaVinci Resolve can now detect individual speakers when transcribing a clip, showing 
specific timecodes as well as the text for each speaker. More details can be found in the 
Edit section of this guide.

File Inspector Audio Properties
The File tab in the Inspector now has an Audio Configuration pane that handles the type of audio 
actions that were formerly handled by Clip Attributes in the Media Pool (though that option is still 
available). The Audio Configuration pane provides a more intuitive and visual way of changing 
the track properties of an audio clip. Simply click on an audio clip in the Media Pool or Timeline, 
and then on the File Inspector to reveal this interface.

The Audio Configuration Panel. Track 3  
has been muted and Track 6 has been disabled.
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The pane features a per-channel waveform display for all tracks within a multichannel audio 
file. If the tracks have been named in the audio recorder, these names will appear over their 
respective tracks as well. 

At the top of the pane a composite waveform is shown of all the tracks and is updated 
depending on the mute status of individual tracks. By default this composite is heard when the 
play button is activated, and all channels are audible.

A Format menu allows you to choose common configurations for your source audio file without 
cumbersome manual re-routing. Custom routing can still be accommodated by choosing 
custom in the drop down, which brings up the older clip attributes for situations that require less 
common configurations.

Audio for a selected source or timeline clip can be played or skimmed by moving the cursor 
along the waveform, and the specific track is solo’ed when skimming or playing. The play 
position or track being monitored can also be switched dynamically during playback. 
For example, you can start playback on track one, then simply click on track two, and the 
playback continues from that position. These controls let you quickly skim through and identify 
exactly what audio is on which track for further adjustment.

Each track has two adjustments that can be made, an Enable/Disable checkbox and a 
Mute button.

	� Enable/Disable: Enabling a track makes that track available for use in editing operations. 
Disabling a track removes that track from use in editing operations. For example, if you 
disable Track 2 of a 4 Track audio file, when you drag that audio file from the Media Pool into 
the Timeline, only 3 Tracks (1, 3, and 4) will come over.
These adjustments can only be made on Media Pool clips; audio clips already in the Timeline 
will have these options disabled.

	� Mute: Clicking this icon will mute the track so it is unheard but leave the actual track in place 
when used in editing operations and dragged into the Timeline.

Underneath the track layout is a simple transport control comprised of Play and Stop buttons to 
start and stop audio playback.

At the bottom of the Audio Configuration panel is a global Level control. This slider controls the 
audio output level for the entire clip and does not work on a per-track basis.

Multiple Clip Selection and Adjustments
You can select multiple audio clips and adjust their properties in the Audio Configuration pane. 
For example, you can select a group of audio files and remove Track 2 from all of them at once. 
However, the following should be noted:

	� In a multiple clip selection, only the last selected clip will appear in the track layout of the 
Audio Configuration pane. However, the top composite waveform will be named “Multiple 
Clips” to let you know that more than one clip has been selected.

	� Any adjustments, like muting or enabling/disabling a track, will be applied to all the selected 
clips at once.
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Blackmagic Cloud
There have been some significant improvements to Blackmagic Cloud, especially for large 
enterprise customers.

Organization Profile Support for Blackmagic Cloud
For larger companies using Blackmagic Cloud, you can now have an organization account 
and set up groups to manage user access to storage, presentations, DaVinci Resolve projects, 
and even set up a dedicated server for your project libraries for the ultimate speed with 
large projects.

Improved Blackmagic Cloud Media Sync Dialog
The Media Sync dialog in Blackmagic Cloud now has an expanded profile area with storage 
quotas, usage, visual indicators, and more granular file sync/proxy status information. The rings 
indicate how much space the project occupies and how much has been synced. You can access 
the file sync history, and under your profile you can see the overall plan capacity (quota) and 
used amount (for the owner).

Open FX DaVinci Resolve Renderer 
plugin for Third Party Applications
The new Open FX plugin DaVinci Resolve Renderer allows third-party applications to open and 
apply DaVinci Resolve’s color changes using exported DRX stills. This can be useful when round 
tripping with various VFX authoring applications where you may want to maintain a look created 
in DaVinci Resolve.

Exporting a DRX still contains much more information about the grade than a simple LUT. DRX 
files can include data, like all the native color and sizing palettes, and other items you stored in 
a Gallery still. This ensures that the grade the colorist created can be exactly replicated in the 
VFX software.

As of this writing the following attributes WILL transfer  
via the Open FX DaVinci Resolve Renderer plugin:

	� All native color palettes (Primaries, HDR, Curves, etc.)
	� All native sizing palettes (Input, Output, Node, etc.)
	� Most Resolve FX
	� Most third-party Open FX

As of this writing the following attributes WILL NOT transfer 
via the Open FX DaVinci Resolve Renderer plugin:

	� Resolve and Open FX that are temporal based
	� Magic Mask

To set up the Open FX DaVinci Resolve Renderer plugin:
	� When installing DaVinci Resolve Studio, select the plugin option in the program installer. 
	� In the third party application, apply the plugin, and select the desired DRX still file. 
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The Open FX DaVinci Resolve Renderer plugin should work with most Open FX-capable VFX 
software, such as Autodesk Flame and The Foundry’s Nuke.

IMPORTANT: Use of the plugin requires a DaVinci Resolve Studio license on the 
system that is running the third-party application.

German and Italian Localizations
Willkommen and Benvenuti to our German and Italian users! You can now see the menus and 
user interface of DaVinci Resolve in your native language. You can change the language settings 
in Preferences > User > UI Settings > Language.

Duplicating Local Project Libraries
Local Project Libraries can be duplicated in the same database for backup or iteration purposes.

1	 Right-click on the Library, and select Duplicate from the drop-down menu.

2	 Select the Resolve Database folder in the file system browser. This can either be the same 
one you use for the original project or a new one.

3	 Click on the Open button.

4	 Rename the new Library in the Clone Library dialog.

Restoring Timeline Backups 
from Deleted Timelines
From the Media Pool options menu, you can select Deleted Timeline Backups and examine 
deleted timelines and available backup files for each timeline. You can select backups to be 
restored or choose to permanently delete selected backups.

Disabling Specific Video  
Tracks for a Render Job
In the Advanced Settings in the Video Render settings tab, you can un-check Render All Video 
Tracks and select specific tracks to exclude from the final output on a per-render-job basis.

8General Improvements



Optimize Audio Loudness  
and Peaks in Render Settings
In the Audio Render settings tab in the Delivery page, a new Audio Normalization audio option is 
available with options to:

	� Normalize loudness or peak (scaling whichever first exceeds thresholds) to a standard,
	� Optimize loudness and peak (ensuring that loudness meets the desired range and peaks 

remain lower than threshold),
	� Use the bus or track audio as-is.

This is enabled by checking on “Normalize Audio” and then choosing the appropriate 
sub-options.

The Audio Normalization settings

Support for HDR Displays on Windows*

You can now display the native viewers in DaVinci Resolve in HDR on Windows systems. 
The setting affects all DaVinci Resolve Viewers, including the Main Page Viewers, Cinema Mode, 
Fairlight Floating Viewer, Scene Cut Dialog, and the Video Clean Feed.

You will need an HDR-capable display and to turn on HDR in the Windows display settings 
(System > Display > HDR). In DaVinci Resolve Preferences > System > General, you will need to 
check the “Use 10-bit precision in viewers if available” box.

NOTE: The general controls/UI and non-Viewer dialogs (e.g., secondary screen, project 
manager, floating Media Pool) are not affected.

* As of this writing, HDR Displays on Windows was not available but will be included in the final release.
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Clip Flags and Colors in Data Burn-Ins
You can now add a clip’s flags and colors as possible options for a Data Burn-In. You can turn 
them on in the Workspace > Data Burn-In dialog. The Clip Color will be represented by an 
appropriate colored dot, and the Flag by the appropriate colored flag icon.

DaVinci Remote Monitoring 
Using IP Address Connections
As an option, you can now use Remote Monitoring over normal IP Address Connections, rather 
than having to sign in through Blackmagic Cloud. However, you will need some technical 
knowledge on setting up your network appropriately.

Setting up Remote Monitoring over IP connections on the Resolve Host 
Follow the instructions below to set up your host grading computer for other people to monitor.

1	 Make sure you are signed out of Blackmagic Cloud in Preferences > Internet Accounts.

2	 In Preferences > System > General, check the “Use Remote Monitoring without 
Blackmagic Cloud” box.

3	 Select Workspace > Remote Monitoring.

4	 Adjust the codec and bit-rate parameters you want, then click Start Session.

5	 Share the IP Address or configured host name for the Resolve host with the clients.

 

The Use Remote Monitor without Blackmagic Cloud 
settings in the computer and iOS versions.
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Setting up Remote Monitoring over IP connections on the Resolve Clients 
Follow the instructions below to set up your client computer to monitor the host’s workstation.

1	 Launch the DaVinci Remote Monitor application.

2	 In the Remote Monitor setup dialog, choose “Use Remote Monitor without 
Blackmagic Cloud.” 

3	 In the iOS or iPadOS versions of the app, go to the iOS Settings > DaVinci Monitor, and 
toggle on “Use Remote Monitor without Blackmagic Cloud.”

4	 Enter the Resolve host’s server IP Address or Host Name in the Host field.

5	 Click Join.

Firewall exceptions and appropriate port forwarding will need to be manually configured in 
order to use this mode. The procedure to initiate a session and accept connections remains 
the same. This mode uses TCP server port 16410 and TCP/UDP port 16411, 16412, etc. for 
each client.

DaVinci Remote Monitoring via 
User‑Specified TURN Servers
When collaborating across complex network security setups that restrict the WebRTC STUN 
protocol, you may now decide to use self-configured or cloud-based TURN servers to route and 
relay monitoring streams. 

To use this function, check the box under Preferences > System > General > Use TURN server for 
Remote Monitoring. Then add the URL of your custom TURN server.

Codecs
As with each release of DaVinci Resolve, more video and audio codecs are supported, and the 
existing codecs’ performance improved.

	� Up to 4x faster H.264 and H.265 decodes on non-Studio in Windows.
	� Up to 2x faster H.264 and H.265 native encodes in Windows.
	� Support for encoding IMF packages with JPEG HT content.
	� Up to 2x faster decodes for ZIP1 compressed OpenEXR sequences.
	� Support for alpha-based HEIC formats.
	� Support for encoding FLAC audio.
	� Support for 44.1 KHz and other sample rate audio in Linux.
	� Render support for odd number resolutions in .mov and .avi clips.
	� Support for decoding cinematic clips captured by iPhone.
	� DaVinci IO Encode plugin SDK support for audio-only formats.
	� Support for GPU accelerated decodes with ARRI Codex HDE SDK 5.2 (Nvidia only for now).

11General Improvements



Scripting API Improvements
Added support for:

	� Managing clip color groups.
	� Querying timeline and group node graphs for a clip.
	� Enumerating tools used in a given node.
	� Setting and getting color keyframe mode.
	� Exporting clip LUTs.
	� Exporting timeline ALE and CDL.
	� Importing OpenTimelineIO timelines with custom import options.
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Media
DaVinci Resolve 19 includes some small but helpful changes to the Media Pool functions.

Updating Clip Usage for All Timelines
You can now see which clips have been used across all the timelines in your project. From the 
Media Pool options menu, select the “Update Usage for Entire Project” option. 

 

The Update Usage dialog

DaVinci Resolve may prompt the user to load all timelines if necessary and update usage counts 
for Media Pool clips. This can take some time, depending on the complexity and number of 
timelines you have in your project.

Once completed, the Usage count across all timelines will appear in the Usage column in the List 
View of the Media Pool.

Select Channels to Synchronize 
Audio Using Waveform
When the Waveform option is selected in the Automatically Sync Audio dialog, you can now 
choose which audio track in the clip to perform the waveform analysis on. This can make the 
analysis more accurate by only selecting the track with the cleanest audio and the strongest 
signal out of a multitrack clip. To do so, click on the appropriate number in the drop-down menu 
in the “Use channel number” box.

The options for Use Channel Number are:

	� #: Uses the selected track number selected for the analysis.
	� Mix: Uses a mix of all the tracks to perform the analysis.
	� Automatic: Lets DaVinci Resolve try to choose the best track(s) for syncing.

13Media



Selecting Track 3 of the clip to perform the waveform sync analysis on

Reveal Media Pool Bin From 
Multi-Bin or Search Displays
If you’ve searched for a clip and have results across multiple bins, you can now reveal where that 
clip is in the Media Pool by right-clicking on the clip and selecting Reveal Media Pool Bin from the 
contextual menu.

The Reveal Media Pool Bin option for multi-bin search results will take 
you right to your clip, no matter where it is in the project.

Media Management Now Retains 
Alpha for Supported Formats
If the media codec you’re using supports using an Alpha channel, you will be happy to know that 
Media Management operations will honor that Alpha channel and pass it through.
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Marker Clips Are Editable 
in the Media Pool List View
Previously when you used Tab to move from clip to clip in the Media Pool List View, the selection 
would skip any Marker clips and go to the next full clip instead. Now the Tab function will stop at 
Marker clips. 

You can also now rename Marker clips and add or adjust Keywords in the Media Pool List View. 
Simply select the clip, and then click on the name in the column. You can then enter any name or 
keyword you wish into the field.

You can now tab to and edit fields in Marker clips in the Media Pool’s List View.

Up to 3.5x Faster Super Scale 
on Supported AMD Systems  
(Studio Version Only)
Super Scale operations that create new high-res media out of low-res sources are up to 3.5x 
faster while using supported AMD GPUs. Most relatively modern AMD GPUs are supported 
including the 6800, 7700, 7900, or higher.
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Cut
The Cut page has received a number of functionality improvements and in addition an update for 
live TV editing, production, and broadcast.

Interactive Resolve FX and 
Fusion Effect Overlays in the Viewer
If you’ve applied a Resolve or Fusion effect that uses on screen controls, you can now use these 
controls in the Cut Page Viewer. To do so, open the Tools panel in the Cut page, and select the 
Effects Overlay icon at the far right.

You have two options below to either manipulate the Open FX or Fusion Overlays; choose the 
appropriate version for your effect. The on-screen controls will then appear in the Viewer.

 

Clicking on the Effects Overlay icon (circled) will activate the on-screen 
controls of Resolve or Fusion effects in the Cut Page Viewer.

Adding Clip Markers From the Source 
Tape Viewer in the Cut Page
When using the Source Tape Viewer, you can now add clip markers to any clip in the source 
tape, simply by pressing the M key at the desired marker location. Tapping M again will bring up 
the Markers dialog box where you can change the marker’s color, add notes, etc. 

Clip Markers Are Displayed 
in the Viewer
Any clip markers that have been added to a clip are now displayed in the Cut page viewer, 
similar to how they are displayed in the Edit page viewer.
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Enhanced Viewer in the Cut Page
The Enhanced Viewer is now available for use in the Cut page. The larger viewer will take up 
the top half of the screen, while leaving the Timeline area in place. You can toggle the Enhanced 
Viewer by pressing Option-F.

 

The Enhanced Viewer in the Cut page

Live Overwrite Painting Starts 
From a Single Frame Duration
When working with the Sync bin and a DaVinci Resolve Speed Editor or keyboard, and performing 
a Live Overwrite, the initial duration of the clip laid down in the timeline is now one frame. 

Replay
The Cut page now allows live multi camera broadcast editing, playout, and replay with 
speed control.

Some of the Replay features are only available with Blackmagic Design hardware, such as a 
desktop video interface, cloud store, and ATEM switcher.

More details will be added at a later date.

Multi Source
Multi Source lets you see all your live cameras, or even just clips in a bin with a common 
timecode, in a multiview screen to look for any point of interest. You can scrub, play, and select 
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shots to add to the timeline or simply play to air. You can even switch live from any of the 
available angles. The Multi Source button is at the top left of the Viewer.

The Replay Multi Source screen lets you see all your available angles.

Point of Interest
When watching live cameras or a multiview of clips and a signifiant event occurs, capture the 
moment with a POI marker. There are two POI buttons at the bottom left of the Viewer. The left 
button lets you clear a POI or add one at a specific time and date. The right button will add a POI 
at the current playhead. You can only have one POI at any one time.

The POI is placed on all the clips at that same time, so you can quickly find the event on every 
camera angle, play them to air, and with the ‘Add to timeline’ option turned on even automatically 
build a highlights timeline.

The Point of Interest marker tags a specific  
timecode number across all camera angles.
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Replay Palette
The pace of live TV is frantic, so the replay controls are clear and quick to navigate. Use the 
Replay Controls button at the top left of the Viewer to display the replay controls.

Set a POI with a single key, select a camera, and cue the event. Then select run to play to air 
automatically via ATEM. You can switch cameras or once it’s done, simply dump the playout to 
prepare the next replay.

At the top right-hand side of the Replay Controls toolbar, you will see an indication of the current 
playback speed in percent and also the time remaining for the current replay based on the 
playback speed and clip length.

The current playback speed (in percent) is shown in the upper right of the Viewer.

Auto Stinger
Stingers are a moving graphics and sound transition to let the viewer know you have switched 
from live to a replay, then back, or even just switched to a new scene. Select auto stingers from 
the Media Pool and play in real time at the head and tail of a replay, even when the replay is in 
slow motion.

The Auto Stingers are transition graphics that can automatically be triggered before or after a replay.
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Edit
The Edit page in DaVinci Resolve 19 has been updated with additional text-based editing 
features and several quality of life improvements.

Text-Based Editing in the  
Transcription Window (Studio Version Only)
DaVinci Resolve 19 brings several new text-based editing and transcription features to the 
Edit page.

Detect Speakers During Transcription
DaVinci Resolve can now detect individual speakers when transcribing a clip, showing their 
specific timecode range as well as the text for each speaker. Speaker detection can not only 
create more useful text transcription exports but can be used for text-based editing references.

Speaker detection is project specific, so once you turn it on, it will remain on for all further 
transcription operations, either for clips or timelines.

 

Turning on Speaker Detection in a clip’s context menu

To Enable Speaker Detection for Transcriptions:
	� Right-click on a clip or Timeline and select Audio Transcription > Speaker Detection. 
	� Or select Speaker Detection from the Transcription window’s Option menu.
	� Click on the Transcribe option to start the operation.

Transcription and Speaker Detection in Timelines
You can also choose to Transcribe and Detect Speakers for a timeline. This will analyze the 
timeline and transcribe the underlying media. It will then give you a timeline transcription based 
off the In and Out points of each clip in the timeline and assign speakers to each segment. 
Timeline transcriptions are opened in Timeline Transcription mode, as described below.

With Speaker Detection enabled, any subsequent audio transcriptions you generate for clips 
and timelines will detect individual speakers. All the speaker’s voice signatures are remembered 
at the project level across multiple clips. If you come back the next day to add more audio 
clips to your project, DaVinci Resolve will remember the voices you analyzed previously and 
automatically assign them to the appropriate speaker. If you want to remove the saved speakers 
from your project, select Reset Speaker Data from the Transcription Window’s option menu.
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In the Transcription window, speakers will initially be listed numerically (Speaker 1, 2, 3 etc.). 
You can change the name of the speaker by double clicking on the speaker name, and entering 
a new name in the text field. All other instances of that speaker will be changed to the new name.

The Transcription window with Display Speakers active. You can change the name of a 
speaker by double-clicking the name, and entering a new one in the text field.

If the Speaker Detection made an error about who is speaking, you can manually re-assign a text 
to another speaker by selecting the text, right-clicking on it and choosing the Assign To icon from 
the pop-up menu. Then another dialog box will appear, letting you change the attribution to any 
of the other detected speakers.

 

You can manually change the speaker attribution by right-clicking on the text and selecting the Assign To icon.

If you wish to hide the speakers again, in order to declutter the Transcription window, you can 
toggle their view on or off in the Transcription window’s Option menu under Display Speakers. 
Toggling this feature does not remove the speaker associations that have already been set.
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Edit Timeline Content Based on Source Clip Transcription
You can use the transcription you generated from the original source clip to subsequently modify 
that clip on the Timeline. Entering this mode in the Transcription window will let you select, cut, 
and paste text and then mirror those changes to the Timeline.

To use Timeline mode in the Transcription window, the clips on the Timeline must be transcribed 
in the Media Pool. To enter Timeline Transcription mode, click on the Timeline icon in the upper 
right of the Transcription window.

The Timeline Transcription Mode icon in  
the upper right of the Transcription window.

Once you’ve activated the Timeline Transcription mode, you can use the text editing tools in the 
window, and those changes will also appear on the Timeline. 

For example, in the clip below, we selected a sentence in the Transcription window, and as you 
can see the In and Out points of that sentence were automatically set in the Timeline behind it.

Selecting a sentence in the Transcription window sets the corresponding In and Out points in the Timeline.

Once you have the text selected, you can manipulate that selection using the standard Cut, 
Copy, Paste, and Delete tools, and mirror those changes to the Timeline. In the example below, 
we will chop out one sentence of a clip, then move it to an earlier position in the Timeline.
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Selecting the first sentence of the second clip, and then right-clicking and using the Cut tool.

Here we see the sentence cut out of the Timeline and replaced by silence (…) in the Transcription window.

Now we select the new In point in the Timeline by selecting the first part of the sentence of the 
first clip in the Transcription window. Then we right-click and hit the Paste command.

The video of the sentence we cut out is pasted in that spot and now comes first in the Transcription window.
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Now we select the hole in the Timeline where we cut out the sentence originally,  
by selecting the (…) silence in the Transcription window. Then right-click and choose Delete.

The final Timeline with the sentence moved and the hole deleted.  
All done just by manipulating the text in the Transcription window.

Adding Clips to Timeline Transcriptions
While you are editing you can continue to add un-transcribed clips into the Timeline. 
When an un-transcribed clip is detected, it is flagged in the Transcription window as 
“Transcription Pending.” In this case, simply select “Transcribe Missing Clips in Timeline” 
from the Option menu to start the transcription of the all missing clips.

When an un-transcribed clip is added to the Timeline, it’s flagged 
Transcription Pending in the Transcription window.

24Edit



Search and Replace Partial Words 
in the Transcription Window
You now have the option to search and replace using partial words in the Transcription window. 
To change the parameters of the search, open the search bar, and select either Contains or Full 
Word from the drop-down menu to the left.

You can now search for partial words in the Transcription window by using the Contains option.

Place on Top Button in the Transcription Window
The Transcription window now has a Place on Top edit button, allowing you to select a range of 
text, then edit that same range of video into a track on top of the current track. This helps make 
cutaways and reaction shots easy to sync up with the master shot.

The Place on Top edit button in the 
 lower right of the Transcription window

Import and Export Transcriptions using SRT Files
Transcription text can now be imported and exported using standard .srt files.

To Import a Transcription using an SRT File:
It’s important that the timecode of the clip you’re importing subtitles to matches the timecode in 
the .srt file for accurate results.

1	 Right-click on a clip in the Media Pool, and select Audio Transcription > Import from Subtitles.

2	 Locate the .srt subtitle file in your file browser, and click Open.

3	 Click on the Transcribe icon in the Media Pool to open the Transcription window to view and 
edit the subtitles.

To Export a Transcription using an SRT File:
1	 Click on the Option menu in the Transcription window, and select Export Subtitles from the 

drop-down menu.

2	 The Export Subtitles dialog box will appear.
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3	 Enter a file output name and path to save your .srt file to.

4	 Enter the subtitle information for Caption Preset, Maximum Characters per Line, Number of 
Lines, and Gap Between Subtitles, as needed.

5	 Click on the Create button to save the .srt file.

The Export Subtitles dialog box from the  
Transcription window’s option menu

Text-Based Editing Honors Timeline Trim and Ripple Modes
Text-based editing will now behave as expected when using them 
with Trim and Ripple modes activated.

Precision Trim Editor 
in the Timeline Viewer
A trim editor similar to the Cut page’s trim editor is now available in the Edit Page Viewer, 
allowing you to see a large display of frame changes on either side of your edit. To access it, 
double-click an edit point, or choose “Trim Editor” from the Trim menu on the selected edit point. 

Trimming Edits in the Timeline Viewer
You can double-click any edit point between two clips in the Timeline to open up the Trim Editor, 
which provides a detailed method of adjusting both halves of an edit point. A graphical A/B roll 
interface shows two filmstrips with the outgoing clip on top and the incoming clip on the bottom. 
These controls are draggable:

	� Drag the left side of the top filmstrip’s handle to trim the Out point of the outgoing clip.
	� Drag the right side of the bottom filmstrip’s handle to trim the In point of the incoming clip.
	� Drag the white handle between the top and bottom filmstrips to roll the edit point, 

simultaneously adjusting the outgoing and incoming edit points.

Numbers over each frame let you see exactly how many frames you’re trimming, while a pair 
of buttons to the left and right of the transport controls in the Viewer toolbar let you adjust the 
outgoing clip’s Out point and incoming clip’s In point in one frame increments.
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The Viewer Trim Editor seen when you double-click an edit in the Timeline

Select Audio Channels When 
Aligning Clips using Waveform
When aligning clips in the Timeline or syncing audio in the Media Pool, a dialog appears, 
allowing you to sync using timecode or waveform. When you choose waveform, a choice of 
channels is now available.

With the default of “Auto,” DaVinci Resolve automatically picks the channels most suited for 
waveform comparison. With “Mix,” DaVinci Resolve compares waveforms from the mixdown 
audio from all available channels. This can be useful when audio may not be present on 
long sections of one or more channels. Users can also specify individual channels to avoid 
noisy audio.

Selecting track 3 of the clip to perform 
 the waveform sync analysis on
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Fixed Playhead Mode in the Timeline
You can now select the fixed playhead mode from the Timeline View options in the Edit page. 
This view option will keep the playhead static in the middle of the Timeline, while the tracks on 
the Timeline move underneath it.

Selecting the Fixed Playhead mode in the Timeline View options

Ability to Edit Text+ Titles in the Viewer
Now, you can double click to access various editing actions directly on Text+ in the Viewer 
overlay, such as editing text, displaying a cursor, and selecting text. This capability extends to 
the Viewer within Edit page when the Fusion overlay is enabled, accessible by selecting the 
“Allow typing in preview” option.

The Number Pad Provides 
Direct Timecode Entry
With full length keyboards, you can now use the number pad for implicit timecode entry 
without invoking the Go to Timecode action. When using a multicam or printer light operation, 
any already mapped number pad key will continue to invoke actions like switching angles or 
incrementing color values.
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Effects Library Improvements
There have been some quality of life improvements in the Effects Library.

Effects Library Favorites Are Now Categorized
When you add a favorite transition, title, audio or video effect, they will now automatically be 
categorized by type in the Favorites section, making it easier to find just the effect you’re 
looking for.

Your Favorites Effects are now automatically categorized by type.
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Fusion
The Fusion page has received new tools, expanded USD capability, and Referenced 
Compositions in DaVinci Resolve 19.

New Fusion Tools
DaVinci Resolve 19 adds several new Fusion tools to its already robust toolset.

USD Updates
The USD tools on the Fusion page have received several updates.

The new uTexture, uTextureTransform, uNormalMap, and uShader nodes give you the ability to 
import and manipulate textures directly in your USD scene without having to wrap them in a USD 
file first. These tools add flexibility and control to your USD workflow within the Fusion page.

Now Fusion lets you more easily render realistic or stylized smoke, flames, and explosions using 
the new uVolume tool. This lets you directly load volumetric VDB files and easily control shading 
and field mapping.

MultiPoly
The new MultiPoly tool makes rotoscoping more efficient by allowing you to create multiple 
masks in a single node. The list of polygon shapes in the Inspector allows you to easily modify, 
organize, and animate shapes through one simple interface.

Shape Tools Updates
The Shape tools have received several updates.

The new sText node allows you to add text directly into your shape-based node trees and the 
new sBSpline node allows you to create B-spline-based shapes.

Also, all shapes now support animation motion paths, and the Shape Tools style tab now includes 
opacity controls.

MultiPoly [Mply]

Introduction
The new MultiPoly tool makes rotoscoping more efficient by allowing you to create multiple 
masks in a single node. The list of polygon shapes in the Inspector allows you to easily modify, 
organize, and animate shapes through one simple interface.

With the multiple masks presented in a scrolling list format, akin to the convenience offered 
by MultiMerge, you can effortlessly organize, edit, and animate individual shapes. This intuitive 
interface streamlines the process of drawing intricate masks, empowering you to create polished 
compositions with ease.

Furthermore, all these advantages are available within this List view, facilitating swift 
selection and modification of specific shapes, toggling their visibility, and adjusting their 
parameters precisely.
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Usage
After adding the MultiPoly, the tool is ready for you to start drawing your first mask.

To create a mask, click in the Viewer to create points; these points will make up segments 
of the polyline. You can close the mask by clicking the initial point again.

The MutliPoly tool showing three creation of masks on the Viewer

The MultiPoly controls

In the Inspector, pressing the Polygon or 
BSpline button will create a new mask type. 
Each new mask is added to the List view 
located in the Inspector.

Within the List view, you can rename or reorder 
any of the masks you’ve just added. Modify 
specific shapes by selecting them in the layer 
list and changing their properties in the lower 
portion of the Inspector.

To animate any of the drawn masks, select the 
animation diamond next to the text “Right-click 
here for shape animation,” at the bottom of the 
Inspector or you can right-click on this text and 
select Animate.

Within the layer list, right-clicking on a mask 
offers a few options.

	� Duplicate: Makes a copy of the selected 
mask and adds a new entry in the layer list.

	� Split here: Splits the selected mask, and 
any mask below it, copying them to a new 
fresh MultiPoly node.

	� Rename: Allows you to rename the 
selected mask.

	� Reset to default: Keeps the mask entry in 
the layer list, but removes the mask shape 
and resets all the controls for that mask.

	� Delete: Deletes the mask.

31Fusion



uVolume [uVo]

Introduction
uVolume is a versatile and powerful tool that simplifies the process of importing volumetric 
VDB files into a USD environment. This node allows you to adjust VDB parameters such as 
density, temperature, and color, giving you complete control over the appearance and behavior 
of the imported VDB file.

Usage
When uVolume is added to the Node Editor, a File dialog is displayed automatically, allowing the 
selection of a VDB file from your media drive.

You can add either a single VDB file or a VDB sequence (animated VDB).

Once a VDB is brought in using the uVolume node, the uVolume can be used for trimming, 
looping, and changing the speed of the imported asset.

You can adjust the density with the Scale control, allowing for precise and fine-tuned adjustments.

The Emission section provides color controls for the VDB. Using the Mode selection pulldown 
will give you the option to select a method for how to change the color of the VDB. Emission 
modes include:

	� Color: Applies an overall ‘diffuse’ color to import VDB. Note: USD lights will not affect a 
VDB with color set to white.

	� Field: Scatters an overall color to a nominated Emission field.
	� Blackbody: Applies color and intensity based on temperature; this is suitable for rendering 

fire and explosions.
	� Gradient: Allows you to map a range of colors over a specified field. The Gradient option 

provides you with a number of controls to target a field, then apply nominated colors to that field.

The uVolume provides the standard transformation controls found on most nodes in 
Fusion’s USD suite. 

The uVolume controls
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uShader [uSd]

Introduction
The uShader is a highly efficient tool, creating complex materials for USD objects. It uses a series 
of predefined inputs that can be easily used for your specific needs. With the ability to work 
with multiple texture files, this node can generate a highly detailed and realistic surface for any 
USD asset, making it an indispensable asset for professionals in the field.

Usage
The node has several predefined inputs, which are mostly all hidden. Unlike other tools, when 
you drag a texture onto this tool, you’ll be shown a list of inputs to assign that texture to. There 
are two shader models to choose from in the Inspector. Each model has its own inputs; switching 
between the models may disconnect any ‘unsupported’ texture.

The uShader controls
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uTexture [uTx]

Introduction
To create a material/surface in the uShader, you can import a texture file using this tool. 
The uTexture sources image files and uses them to build the material/surface in the uShader.

Usage
After adding the node to the Node Editor, use the Browse button to select an image file from 
your hard drive. Alternatively, you can click and drag an image from the Media Pool directly 
onto the “File Name” control in the Inspector to load an image that has already been imported 
into DaVinci Resolve. Use the “Source Color Space” control to choose how the image will be 
read by the uTexture tool. It’s important to select Linear when loading a Normals image to get the 
best results. 

U/V Address Mode controls offer a useful way to determine how the edges of the image are 
treated when exposed due to scaling. 

The uTexture controls

uTextureTransform [uTXf]

Introduction
uTextureTransform provides you with granular control over the Scale, Rotation, and Position of 
each loaded texture file. With uTexture Transform, you can quickly and easily tweak the size, 
orientation, and placement of any texture file sourced from the uTexture node.
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Usage
To use uTextureTransform, place it after a uTexture node and before a uShader node. This node 
only works between the the loaded texture and uShader.

Adjust the Scale, Rotation, and Position settings to your liking.

The Scale setting allows you to increase or decrease the size of the texture file, while the 
Position setting lets you move the file around within your project. You can also use the Rotation 
setting to rotate the texture file to any angle you desire.

The uTexture Transform controls

uNormalMap [uNm]

Introduction
The uNormalMap tool provides several controls to modify a “normals” texture before it’s passed 
onto the uShader. This allows you to manipulate the texture in various ways and ensure that it 
is optimized for your specific needs. Once any necessary adjustments have been made, the 
modified image is then passed onto the uShader.

Usage
To use uNormalMap, place it after a uTexture node and before a uShader node. This node node 
only works between the the loaded texture and uShader.

The uNormal Map controls
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uDuplicate [uDp]

Introduction
Similar to the 2D and 3D Duplicate nodes, the uDuplicate node can be used to duplicate any 
USD asset in a scene, applying a successive transformation to each, and creating repeating 
models and complex arrays of objects. The options in the Jitter tab allow non-uniform 
transformations, such as random positioning or sizes.

Usage
Add the uDuplicate node after a USD asset you want to duplicate. Within the Inspector, nominate 
how many copies you’d like and change the relative position, rotation, or scale. This creates 
an exact copy of the upstream node or nodes, mimicking any animation or textures from the 
source asset. 

The uDuplicate controls
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sText [sTxt]

Introduction
Designed for the Fusion Shape environment, the sText node is an advanced character generator 
capable of multiple styles, 3D transformations, and several layers of shading. The sText node is 
a “Shape” version of the 2D Text+ node. The controls for this node are mostly identical to the 
controls for the 2D version in almost all respects, except sText doesn’t support gradient colors. 

The sText controls
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sBSpline [sBSp]

Introduction
sBSpline is identical to a sPolygon in all respects except one. Where sPolygon use Bézier splines, 
this node uses B-splines. Where Bézier splines employ a central point and two handles to 
manage the smoothing of the spline segment, a B-spline requires only a single point. This means 
that a sBSpline shape requires far fewer control points to create a nicely smoothed shape.

Usage
When first added to a Node Editor, the sBSpline shape consists of only Center control, which is 
visible onscreen.

Points are added to the sBSpline by clicking in the viewer. Each new point is connected to the 
last one created, but instead of the spline going directly through each control point, sBSpline 
control points only influence the spline shape. The Control point pulls the spline in its direction to 
create a smooth curve.

Like the sPolygon shape tool, the sBSpline shape auto-animates. Adding this node to the Node 
Editor adds a keyframe to the current frame. Moving to a new frame and changing the shape 
creates a new keyframe and interpolates between the two defined shapes.

The sBSpline controls

Referenced Fusion Compositions
DaVinci Resolve 19 introduces a powerful new way of applying Fusion composites to your clips 
called “Referenced Composition.” This method allows you to reuse your work across multiple 
clips or even timelines.

You create a referenced composition on the Edit page by selecting a single clip, or a stack 
of clips, and then select “Create Referenced Composition” from the contextual menu. This 
generates a Fusion Referenced Composition in the Media Pool. You can enter the Fusion page 
to start compositing or double click the Referenced Composition in the Media Pool to open it.
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Referenced comps can be linked to other clips in any timeline by selecting the referenced comp, 
then right-clicking the target clip and selecting “Link to Referenced Composition.” Any changes 
you make are applied across all connected clips because they are all “referred” or “linked” to the 
same composition.

Referenced compositions are an effective and secure way to keep your work backed up and 
organized, as they live in the Media Pool and will persist even if the original referenced clip is 
deleted from the Timeline.

Creating and Managing Referenced Compositions
To create a referenced composition: 
1	 Select one or more Timeline clips that are “stacked” on tracks in an Edit window timeline 

(clips have to overlap in time at least partially). 

2	 Right-click and select “Create Referenced Fusion Composition.” 

3	 The new reference composition, associated with the top selected clip, 
now appears in the Media Pool.

You can open the referenced composition in the Fusion page by double-clicking on it in 
the Media Pool. Media nodes match the relative locations of the source track clip arrangement in 
the Edit timeline.

The contents of the video track are treated as a source, allowing creative manipulation of clips 
before they’re passed on to Fusion for compositing.

You can right-click on a referenced composition in the Media Pool and choose the 
Usage option to view and navigate to its target linked clips.

You can duplicate your referenced composition for iteration purposes.

In the example below, we create a simple reference composition out of three clips, replacing 
a logo on a truck.

Creating a reference composition by selecting multiple overlapping clips, and then 
choosing Create Referenced Composition from the contextual menu.

The Reference 
Composition 
thumbnail in 
the Media Pool
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Double-clicking on the Reference Node brings us into Fusion, where we add some Corner 
Positioner nodes to line up the green stripe and logos to fit.

Now that we have the referenced composition set, we can easily change the logo, just by 
performing a replace edit with the new logo to V3 in the Timeline. The new logo is automatically 
applied in the Fusion comp with the same settings.

The new logo on V3 in the Timeline
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Adding Additional Referenced Clips
Once you’ve established a referenced composition, you can add clip(s) that can use the 
referenced composition to affect the other clips. 

To add clip references to a referenced composition:
1	 Select the referenced composition that you want to refer to another clip. 

2	 Select a target clip in the Timeline, right-click and choose “Link to Referenced Composition.” 

3	 Add other clips one at a time, if you wish, including clips from other timelines. 

Referenced Composition Behaviors and Rules
There are some additional behaviors and rules to be aware of when using 
referenced compositions.

	� Referenced compositions maintain the original source resolution of your clips.
	� When selecting multiple clips, ensure that the clips have some overlap with the top selected 

clip. Without this overlap, the context menu action to create a referenced composition across 
layers is not available.

	� When creating a project composition from multiple overlapping clips, a single composition 
associated with the top selected clip is created.

	� The referenced composition features additional Media In nodes (one per track). Media In 1 
refers to the top selected clip. Subsequent Media In nodes reference timeline tracks (layers) 
below the top clip. 
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	� Removing a timeline clip will not remove the associated composition.
	� When you edit the contents in a referenced composition’s track, the corresponding Media In 

refreshes to automatically to show the new clips, edits, effects, and transitions.
	� From the timeline clip’s context menu, you can:

•	 Reset Reference Composition: To reset the composition. This affects all 
referenced clips.

•	 Unlink Composition: To remove the composition reference from the selected clip. 
This retains the composition in the Media Pool, but the clip effect is cleared. Useful if you 
want to link to another referenced composition.

•	 Find Reference Composition in Media Pool: To find the reference composition the clip 
is a part of in the Media Pool.

NOTE: Clips of differing frame rates or clips with speed changes are not supported in 
Referenced Compositions.

Improved Text+ Inspector 
and On‑Screen Controls
Now, you can double click to access various editing actions directly on Text+ in the Viewer 
overlay, such as editing text, displaying a cursor, and selecting text. 

Alternatively, hover over the popup toolbar within the Fusion viewer and activate it, or right‑click 
on the View menu. This functionality is intuitive; when Text+ is selected, double-clicking 
anywhere in the Fusion viewer activates the in-viewer text editing mode.

The Text+ on-screen viewer editing controls in the Fusion viewer

This capability extends to the viewer within Edit page when the Fusion overlay is enabled, 
accessible by selecting the “Allow typing in preview” option.
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The Text+ on-screen viewer editing controls in the Edit Page viewer. Note that 
you must turn on the Fusion Overlay (circled) in the bottom left.

Within the Fusion viewer, you’ll also find pivot points for your Character, Word, and Line 
transforms. For easy access, a Pivot Points icon has been added to the popup toolbar, allowing 
you to toggle their visibility when adjusting rotation and scaling transformations.

Also new is the Z position-based sorting mode, a powerful addition to our toolkit. In contrast 
to the Distance mode, which sorts based on absolute distance from the camera, this mode 
sorts solely on the Z distance from the camera, irrespective of the relative orientation. 
With Z position, you can flexibly arrange overlapping text elements, ensuring precise layering 
and depth management.

Moreover, character-level styling has been refined to facilitate more intuitive offsets and 
translation transformations. This enhancement reduces the need for manual positioning and 
ensures a consistent application across multiple separate character selections.

New IntelliTrack AI Point Tracker
The Fusion Tracker node now defaults to using IntelliTrack, the new DaVinci Neural Engine 
tracker. Using AI makes tracking easier and more precise, especially when tracking many points.

IntelliTrack harnesses the intelligence of the DaVinci Neural Engine to track objects accurately 
within a shot with extreme precision. The track is exceptionally robust and tight due to the 
underlying AI engine.

NOTE: The original point tracker is still available to use by choosing the Point button.
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Adding a Tracking Point in the IntelliTrack mode in the Fusion tracker

Miscellaneous New Features 

Support of Open Color IO 2.3
The Fusion page now integrates OpenColorIO 2.3 workflows, with support for:

	� Faster and more accurate transforms for viewers that do not clip HDR content.
	� New view LUT options for display transforms, including ACES workflows.
	� Display transforms to use system ICC profiles for monitor correction on Windows and Mac.

USD Toolset Enhancements
The USD toolset contains multiple improvements, including:

	� Multiple tools have been upgraded to reflect a deeper integration of MaterialX surface and 
volumetric tools, and now offer more control over texture animation, depth, lighting, and 
transparency.

	� Improved shadows for USD spherical and cylindrical lights.

Multiple Shape Toolset Enhancements
	� Shape tool controls in the Inspector feature new opacity controls.
	� All shapes now support animation motion paths.
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Color
The Color Page has seen major improvements in DaVinci Resolve 19, including ColorSlice 
(a vector-based grading tool), and Node Graph Stacks to help organize your Node Graphs. 

Support for the DaVinci Resolve 
Micro Color Panel
The DaVinci Resolve Micro Color Panel is Blackmagic’s newest and smallest control surface for 
color grading. It’s available for DaVinci Resolve 19 on Mac, Windows, and iOS.

The DaVinci Resolve Micro Color Panel

ColorSlice
ColorSlice is a fixed vector grading tool that cuts the standard color wheel into six slices based 
on the conventional vectors on the Vectorscope: Red, Green, Blue, Cyan, Magenta, and Yellow. In 
addition a seventh vector has been added for Skin Tone.

The ColorSlice vector-based grading tool
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You can set overall density, saturation, and hue parameters to customize different CMY print 
processes and change brightness and saturation for each vectorspace slice. To achieve deep 
filmic colors and looks, brightness is controlled in a subtractive way when adjusting saturation, 
so saturated colors are not unnaturally bright and do not need luminance adjustments.

The Red ColorSlice 
Vectorspace controls

Each vectorspace slice is composed of the following controls:

	� Highlight: Clicking on this icon will enable a Highlight view, 
showing the areas of the image that will be modified by the 
control. You can also use this view to make it easier to refine the 
parameters below.

	� Vector Name: A name that represents the color of the area 
controlled (Red, Green, Blue, etc.).

	� Reset: Resets the all the Vectorspace controls back to the 
default levels.

	� Color Wheel: A visual representation of the vectorspace slice. All 
colors within the triangle are what will be adjusted by the controls.

	� Center: This is the only adjustable qualifying control. Sliding this 
back and forth will move the triangle in the color wheel, letting you 
slightly change which colors fall within the vectorspace. Use this 
tool in conjunction with the Highlight view to make sure that the 
specific colors you want to adjust are qualified.

	� Hue: Changes the hue of all the colors within the vectorspace slice.
	� Density: Adjusts the density of the colors inside the vectorspace 

slice by adjusting the luminance of more saturated colors to 
emulate a subtractive color film process.

	� Saturation: Adjusts the saturation of colors qualified by this slice 
using a subtractive color model that prevents highly saturated 
colors from becoming unnaturally bright.

Global Controls
In addition to the individual Vectorspace controls, there are a set of global controls along the top 
of the tool. These will change the values of the entire image.

The ColorSlice Global controls

	� Density: Adjusts the luminance of more saturated colors to emulate a 
subtractive color film process.

	� Density Depth: Controls the effect of density adjustments on brighter areas of the image.
	� Saturation: Adjusts saturation using a subtractive color model that prevents 

highly saturated colors from becoming unnaturally bright.
	� Saturation Balance: Adjusts how saturation changes effect the luminance 

balance in colors with medium saturation levels.
	� Saturation Depth: Controls the effect of saturation adjustments on 

brighter areas of the image.
	� Hue: Changes the hue of all the colors within the image.
	� Reset: Resets all ColorSlice adjustments.
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Node Graph Stack
The Node Graph Stack allows management of complex grading workflows by creating multiple 
sequential node graphs that let you break up grades into separate sections. This allows 
users to isolate related functions like stabilization, corrections, hero grades, and display trims 
into individual node layers. Grade operations like ripple, reset, and editing can also be done 
on a per-layer basis.

The Node Graph Stack Count settings and naming options

From Project Settings > General Options > Node Graph Stack Count, users can set the number of 
clip node graph layers in the Node stack up to 4. You can also add custom names to the layers 
such as “primaries,” “secondaries,” “finishers,” etc.

The Node Graph Stack is navigated by clicking on the dots above  
the Node Graph. The name of the active layer is directly to the right.

Users can then select individual layers from the navigation dots above the Node Graph or from 
the Option menu.

IMPORTANT: All node layers are applied sequentially to the clip: pre-clip, L1, L2, L3, L4, 
post-clip, and then Timeline.
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Support for ACES AMF 2.0
DaVinci Resolve now supports ACES AMF 2.0 files for import and export. ACES AMF is a sidecar 
file written in XML that define the input and output transforms of the clip. This makes sure that 
the correct input and output transforms are applied throughout the post production pipeline. 
These files can either be loaded at a project level or a clip level. Clips with the “applied” attribute 
set to true are tagged appropriately with no transforms applied. However, if they are set as false, 
the transform is applied within DaVinci Resolve.

NOTE: You must use version 1.3 or above of the ACEScc or ACEScct Color Science to 
use AMF files.

Working with AMF Files
	� Project level AMF: These will have all transforms applied (i.e., any defined input, look, 

or output transforms which have their “applied” attribute set to false will be applied). The 
input and output transforms are applied via the project settings “ACES Input Transform” and 
“ACES Output Transform” menus, and these menus will display “From AMF” if they are using 
a transform from the loaded AMF file. 

	� Clip level AMF:  An AMF can be loaded from the Color page clip thumbnail context menu 
from the Clip AMF menu. This list is also populated from the ACES Transforms AMF subfolder. 
A clip level AMF will not apply the output transform; that can only be applied from project 
settings. Any input or look transforms will have their “applied” attribute set to false. The look 
transforms are applied within a compound node labeled AMF LMTs.

	� ACES Gamut Compression: If the ACES reference gamut compress algorithm is specified 
in a look transform within the AMF, it will set the “Apply ACES reference gamut compress” 
checkbox to checked. The user can see what input, gamut compress, look, and output 
transforms are applied by clicking the “View Transforms” button at the bottom of the “Color 
Space & Transforms” section of the Settings > Color Management section. 

To Import an AMF
1	 Place your AMF files in the ACES Transforms/AMF directory on your computer. This is 

folder is found at:
•	 MacOS: the users Library/Application Support/Blackmagic Design/DaVinci Resolve/Aces 

Transforms/AMF 
•	 Windows: the users AppData\Roaming\Blackmagic Design\DaVinci Resolve\Support\

ACES Transforms\AMF
•	 Linux: opt/resolve/Developer/DaVinciCTL/AcesTransforms/AMF

2	 In the Project Settings, set the Color Management > Color Science setting to ACEScc or ACEScct.

3	 Select the ACES version to be 1.3 or above.

4	 Click on the ACES AMF drop-down menu, and select the AMF from the list.

Exporting AMF Files
There are three choices to select from when you export an AMF file.

Source Master mode:
	� All the applied attributes will be set to false.
	� A source master is not associated with any clips or images.
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Dailies Request mode:
	� You can select the folder to store the output AMFs.
	� A dailies AMF is created for and associated with each clip, and the applied attribute will be 

set to false.

VFX Request mode:
	� A VFX AMF will only have the input transform with the applied attribute set to false.

AMF Delivery Behaviors
	� For AMF delivery, the export AMF option can be chosen in the Deliver page render settings. 
	� When using Source Master, the images are rendered to ACES AP0 or Linear masters with 

only the input transforms applied; all other transforms are set to applied false. 
•	 The resulting AMF is not associated with any clips or images with an aim to define 

and transmit a color pipeline with its post production look alongside ACES AP0 or 
Linear data. 

	� In Dailies Request, all transforms are applied on the rendered images and all transforms are 
set to applied true. 

	� The resulting AMF is associated with each clip in the project. 
	� In VFX Request, the clips are rendered to ACES AP0 or Linear with only the input transform 

applied and all other transformed are set to false.

To Export an AMF
1	 Right-click on your timeline in the Media Pool.

2	 Select Timelines > Export >AMF in the contextual menu.

3	 Choose the type of AMF file to export: Source Master, Dailies Request, or VFX Request.

4	 Enter the name of the AMF file and its save location in the file browser.

5	 Click on the Save button.

Normalize Channels in the RGB Mixer
The RGB Mixer now has an additional Auto Normalize control for each channel. These per-channel 
normalize controls allow for users to adjust channel mixes without affecting overall luminance.

The Auto Normalize control on the red channel of the RGB Mixer
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SDI Output Shows Advanced 3D Keyer 
Strokes and Marker Annotations
When you make strokes in the 3D Keyer, or annotations in the viewer, these can now be output 
to your grading monitor from the Color page viewer. Simply click the Color Page Viewer Option 
menu, and select Video Output Options, and choose your options from the drop-down menu. 
Unchecking the option removes the overlay from the SDI output going to your grading monitor.

Turning on the Annotations Video Output option to show the overlay on the grading monitor

Double Clicking to Open 
a Compound Node
As of DaVinci Resolve 19, you can now enter any compound node, simply by double-clicking it. 
Exiting back to the main node tree still requires you right-click in the Compound Node view and 
select “Exit Compound Node.”

Preview Matte Node Layers by Option 
Hovering Over Layer Entry
When working with a node with multiple matte layers, such as an .exr file, you can now preview 
individual matte layers. To do so, right-click on the node, select Add Matte from the contextual 
menu, and hover over the name of the file. A list of all the layers in the node will appear, and 
by holding down the Option key while hovering over each layer, it will appear in the viewer. 
This can let you quickly check to see if you are working with the correct matte layer (arm, wheel, 
shirt, etc.), regardless of what the matte has been named in the file. 
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Node Context Menu Actions Can 
Have Assigned Shortcut Keys
You can now assign shortcut keys to Node Context menu actions, like Lock Node, HDR Mode, 
Clean Up Selected Node Graph, etc. Go to Keyboard Customization > Commands > Panels > 
Color Nodes to assign the shortcuts.

Cleanup Node Graphs for 
Multiple Selected Clips
If your grading has gotten slightly out of control, you can now use the Cleanup Node Graph 
command on multiple clips at the same time. To do so, select the clips whose Node Graphs you 
want to tidy up in the Thumbnail timeline, then right-click in one of their Node Graphs and choose 
“Cleanup Selected Node Graphs” from the drop-down menu. This will perform a Cleanup Node 
Graph operation on all selected clips at the same time.

Creating Smart Filters for 
HDR Graded Clips
HDR Graded clips can now be a criteria used for creating Smart Filters in the 
Create Smart Filter dialog box.

Improved Stereoscopic 3D Control 
Layouts on Advanced and Mini Panels
The Stereoscopic 3D settings on the Advanced and Mini panels have been reorganized for 
better efficiency and control.

Link Target Display Selection 
with Dolby Vision Trim Control 
Display Options
In the Dolby Vision controls, you can now link the Target Display Output and the Trim Controls 
for Fields by clicking on the little Chain icon directly to the left of the options. This automatically 
changes the Trim Controls for Field to the same value you set in the Target Display Output, 
ensuring your trim controls are always right for the selected display.
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Support for HDRVivid SDK 1.5
HDR Vivid controls have been updated to support HDRVivid SDK 1.5.

Support for FujiFilm F-Log and F-Log2 
for Color Managed Workflows
DaVinci Color Managed workflows now supports video clips shot in Fujifilm F-Log 
and F-Log2 color spaces.

Up to 3x Faster Resolve FX Beauty, 
Edge Detect, and Watercolor in Mac OS
The speed of the Beauty, Edge Detect, and Watercolor Resolve FX have been increased by up 
to 3x in MacOS.

Up to 2x Faster Resolve FX Beauty, 
Edge Detect, and Watercolor with 
NVIDA GPUs
The speed of the Beauty, Edge Detect, and Watercolor Resolve FX have been increased by up 
to 2x in systems using NVIDIA GPUs.
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Color FX
DaVinci Resolve 19 includes new Resolve FX for creating Film Looks, Defocusing Backgrounds, 
and improvements to Face Refinement. 

Defocus Background
The Defocus Background effect lets you blur only the background of an image and provides a 
detailed set of tools to mimic shooting with a shallow depth of field. 

The original image with a busy, distracting background

Using the Defocus Background effect to blur the background, making it 
less distracting, and mimicking a shallower depth of field.
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The Defocus Background effect does not qualify or isolate the foreground subject. In order 
to use the Defocus Background, you must first isolate the foreground subject using an effect 
or mask using another tool like Magic Mask or a Power Window. You can then apply Defocus 
Background either to the same node or connect the key output from a previous node.

Connecting the key output of the Magic Mask to the Defocus Background effect. Defocus Background 
requires a key generated from another tool like Magic Mask or a Power Window to work.

Adjust Mask
These controls let you adjust the mask that separates the sharply focused areas from the areas 
you want to blur.

The Mask Preview option shows where the defocus operations will take place (black areas).

	� Mask Preview: Checking this box will bring up a black and white preview of your mask. 
The white areas of the mask will stay sharp, while black areas of the mask are what will be 
blurred using the Mask controls below. This is convenient to have up while you’re perfecting 
the mask, then disabled to see the output of the Effects and Advanced options.

	� Mask Invert: Checking this box will invert the mask, making the white areas black and 
vice-versa.

	� Mask Blur: This control adjusts the size of the Blur around the mask; this lets you smoothly 
blend the foreground and background together.

	� Mask Contrast: This controls how strong the divide is between the focused and blurred 
regions of the matte.

	� Adjust Pivot: This allows you to set where the divide is between the focused and blurred 
regions of the matte.
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Effects
These controls set the main characteristics of the blurred area.

	� Blur: This slider controls the size and how much blur to apply to the blurred area.
	� Saturation: This slider controls the saturation of the blurred area. 1.000 (default) is full 

saturation. A value of 0.000 makes the blurred areas monochrome.
	� Colorize: This slider controls the amount of color to tint the blurred areas. 0.000 is the 

default (no colorization).
	� Color: This is the color picker for the Colorize operation above.

Advanced Options
These controls let you adjust some of the physical characteristics of the blurred area.

	� Blur Type: This lets you choose the blurring algorithm used to make the blur. Either Lens blur 
or Gaussian blur are options.

	� Anamorphism (Lens Blur): This slider lets you set the aspect ratio of the blur to match 
different lens types.

	� Highlights (Lens Blur): Lets you adjust how the highlights of the image affect the blur, 
dilating or eroding the image.

Face Refinement Improvements  
(Studio Version Only)
The Face Refinement effect has been improved with better tracking, profile handling, and smooth 
skin options. The newly revised effect is described below:

Face Refinement is an incredibly sophisticated yet easy-to-use filter that lets you quickly make 
very targeted adjustments to people’s complexions. 

In order to use the face refinement toolset, the first thing you need to do is to identify the face (or 
faces) you wish to work on, and then analyze and track that face through the clip.

Identifying a face is done by clicking on the Detect Faces in Frame button. If faces are present 
in the frame at the position of the playhead, then this results in boxes being drawn over each 
detectable face. Click any of these boxes to choose which face you want to refine, and that box 
will be highlighted in green to indicate which face you’ll be refining.
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When multiple faces are detected, you can click a box to choose which one to work on

After you’ve selected which face to work on, you need to use the tracking controls to 
track the face through the clip, and an outline of the face’s major features appears to let you 
follow its progress.

The Face Refinement filter detecting a performer’s face

The basic tracking controls usually work well enough to track faces in most instances. 
However, in some tricker cases if the subject’s head tilts away, or if it’s occluded by something 
else in the frame, you may have to manually adjust the track. You can do this by going to the 
last known good point of the track and then checking the Interpolate (Keyframed) box. This will 
add keyframes automatically for the frame and turn the outlines blue to let you know you are in 
Manual mode. Then you can go to the problematic frames and click and drag to manually adjust 
the entire face or select and adjust each individual feature as needed. Once you get to a point 
where the automatic tracking works again, you simply uncheck the Interpolate box and let the 
automatic tracker take it from there.
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.

Manually adjusting an eyebrow in the 
 Interpolate (Keyframed) mode

Once the face has been tracked, you’re ready to work. This plugin divides the tracked face into 
different zones for common operations colorists often perform to eliminate blemishes quickly, 
adjust the hue and saturation of complexions in regionally appropriate ways, modify lighting, 
sharpen desirable detail, and refine makeup. Because all adjustments are fit to the proportions of 
the face that’s been detected and tracked, all you need to do is make the adjustments you need 
and DaVinci Resolve takes care of the rest.

Main Controls
The top controls let you initiate the Face Refinement process.

The tracking controls for Face Refinement

	� Detect Faces in Frame: This button initiates the process of using the facial detection of the 
Face Refinement plugin to detect the face you want to make adjustments for.

	� Tracking Controls: Basic tracking controls to identify facial features motion through the clip.
•	 Track Reverse: Identifies the face and tracks it backward through the clip.
•	 Track Reverse 1 Frame: Identifies the face and tracks it backward 1 frame.
•	 Find in Frame: Identifies the face in the current frame.
•	 Track Forward then Reverse: Identifies the face then tracks it forward from the current 

position and then reverse from that position.
•	 Track Forward 1 Frame: Identifies the face and tracks it forward 1 frame.
•	 Track Forward: Identifies the face and tracks it forward through the clip.

	� Show overlay: To impress your clients and see how well Face Detection is tracking the face 
you’re working on, you can turn on this checkbox, which turns on the wireframe tracking that 
shows you which facial details are being detected.
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Face Location
These controls let you adjust the strength of the effect, as well as make manual adjustments to 
the face and its features position in the frame.

	� Effect Strength: This slider determines the relative strength of the adjustments made with 
the original image. 1.000 is full strength, while 0 turns the effect completely off.

	� Interpolate (Keyframed): Checking this box lets you make manual adjustments to the face 
and feature tracking in the viewer, and automatically keyframes any changes. Click and drag 
in the viewer to move the entire face. Shift-click and drag to reframe the face. Click on any 
individual feature to adjust, or any dot to move its position.

Skin Isolation
These controls let you adjust the skin mask this plugin automatically generates in order to limit 
the effect to only the face of the person you’re targeting.

Adjusting the key with the face mask active

	� Show mask: This checkbox makes the face mask being generated visible, which can be 
helpful to see while you’re tuning it.

	� Skin Mask Source: Lets you select the source for the skin mask. DaVinci Resolve’s Internal 
Skin Model is the default, but there is the ability to use the Input Alpha if you’ve qualified the 
skin tones in another node. None disables the mask.

	� Shadow Range: This control lets you extend or erode the shadows of the face detected by 
the skin model. 

	� Tint Range: This control lets you extend or erode the tint range detected by the skin model.
	� Temp Range: This control lets you extend or erode the color temperature of the face 

detected by the skin model.
	� Limit to Face Region: Turning on this checkbox places a circular garbage mask that follows 

the face to eliminate any accidental qualification of areas outside the face.
	� Region Size: Lets you adjust the size of the face mask.
	� Region Softness: Lets you adjust the edge softness of the face mask.
	� Flat Skin Areas Only: Checking this box will exclude the nose and eye socket regions from 

the mask, allowing you to work only on the facial skin itself.
	� Exclude Mouth: Checking this box will exclude the mouth region from the mask, allowing 

you to work only on the facial skin itself and not the lips.
	� Denoise mask: This slider lets you fill in areas of small detail in the mask.
	� Refine mask: This slider lets you adjust the face mask to smooth or eliminate gaps in the key.
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Skin Texture
The Skin Texture controls have three Operating modes that let you choose the method you 
want to use to control skin texture. Beauty Automatic and Beauty Advanced provide the texture 
controls available in the Beauty plugin, while Smoothing provides the previously available texture 
adjustment controls.

Beauty Automatic Controls
Automatic mode reveals easy-to-use controls for smoothing or coarsening detail.

	� Amount: Lets you choose how much smoothing or coarsening to apply.
	� Scale: Lets you reduce or increase the amount of smoothing or coarsening that’s 

accomplished with the range of the Amount slider. 

Smoothing Controls
	� Smoothing: This slider removes detail from the areas isolated by the Skin Mask controls, 

smoothing the complexion. Its operation depends on the settings of the Detail Size and 
Detail sliders below. You may find you can increase Smoothing more dramatically as you 
increase Detail using the Detail Size and Detail sliders described below.

	� Detail Size and Detail: Once you’ve used the Smoothing slider, you can then use these 
sliders to selectively put subtle skin details back into the image. Detail Size determines 
the maximum size of details you want to put back into the face, and Detail is a sharpening 
operation that lets you adjust how visible these small details are. By combining smoothing 
and subtle preservation of small details, you can get a much more naturalistic result than 
were you to simply leave the entire face unnaturally smooth.

The original image

Only smoothing complexion Using Detail Size and Detail to put natural 
texture back into the smoothed result 
(results exaggerated for print)
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Beauty Advanced
These controls are identical to the Advanced controls of the Beauty plugin, covered previously in 
this chapter.

Skin Grading
These controls let you make color adjustments to the overall face.

	� Contrast: This slider lets you lighten the face in a natural way by keeping the shadows dark 
even while you brighten the face, making it easy to bring actors out of the background.

	� Midtone: Lets you add a more luminous quality to the skin tone. 
	� Color boost: Specifically boosts saturation in the lowest saturated parts of the face. 
	� Tint: Provides a limited range of naturalistic hues, emphasizing orange through red (but 

extending to green and magenta) with which to tweak complexion. 
	� Desaturate shadow: This slider lets you selectively desaturate the darkest shadows on the 

face to keep things looking natural or to desaturate more aggressively in order to stylize the 
face in a different way. Also useful when using the other adjustments of this plugin makes the 
shadows too colorful. Moving this slider into negative values will add saturation.

	� Shine Removal: This slider is an inverse contrast adjustment designed to ameliorate sweat 
and shine on a person’s face, although moving this slider into negative values will also 
accentuate shine.

Side Lighting
These controls allow you to fill in or accentuate shadows and balance the light between the 
sides of the face.

	� Lift Left/Right: Adjusts the dark parts of the image for a side of the face. 
	� Gamma Left/Right: Adjusts the midtone parts of the image for a side of the face.
	� Gain Left/Right: Adjusts the bright parts of the image for a side of the face.
	� Area Size: This control lets you adjust the size of the area of influence of the side lighting.
	� Bias Left/Right: Normally, the left and right sides of the face are split right down the nose. 

You can use this control to adjust the center of the effect manually, if necessary.
	� Area Softness: This control adjusts the softness of the effect around the side of the face. 

Eye Shadow
These controls give extensive control of the eyelids and sockets, without manipulating the 
eyes themselves. Used subtly, it can easily remove bags under the eyes or accentuate makeup 
details. Used aggressively, you can create realistic eye makeup effects from nothing. There are 
separate controls for the upper and lower eyelid areas.

	� Temp Upper/Lower: Adjusts the color temperature of the eyelid.
	� Tint Upper/Lower: Adjusts the tint of the eyelid. 
	� Hue Upper/Lower: Adjusts the color of the eyelid.
	� Saturation Upper/Lower: Adjusts the saturation of the eyelid.
	� Gamma Upper/Lower: Adjusts the gamma of the eyelid.
	� Size Upper/Lower: Adjusts the size of the area of the eyelid modifications.
	� Softness Upper/Lower: Adjusts how soft the blending is between the eyelids and the face.
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	� Strength Left/Right: Lets you set different strengths for the left or right eye to compensate 
for lighting differences between the sides of the face.

The original image

Using the Eyeshadow tools to change the model’s upper  
eyeshadow color to purple and increase the intensity

Eyes
These controls target just the eyes and surrounding area of the face.

	� Sharpening: This slider lets you selectively add sharpening just to the eyes and eyelashes, 
which lets you instantly add focus to any performer. 

	� Brightening: This slider lets you whiten the eyeballs.
	� Eye Light: This slider lets you brighten the region of the face around the eyes that’s often 

thrown into shadow by the subject’s forehead in situations with imprudent lighting. 
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	� Eyebag Removal: This slider uses a variety of techniques to smooth, color-adjust, and 
brighten the area under the eyes most susceptible to eye bags with tired talent.

Eyes with no special adjustment

Eyes with adjustment

Lips
These controls target just the lips and surrounding area of the mouth.

	� Hue Shift: This slider lets you adjust the color of a subject’s lips or lipstick. 
	� Saturation: This slider lets you adjust the intensity of lip color. 
	� Gamma: This slider lets you adjust the lip brightness using a gamma curve.
	� Upper Lip Smooth: Lets you smooth out fine age lines that can appear above lips.
	� Mouth Corners Inner/Outer: Adjusts the side corners of the mouth. 
	� Top Inner/Outer: Adjusts the top boundary of the lips.
	� Bottom Inner/Outer: Adjusts the bottom boundary of the lips.
	� Softness: The softness of the blend between the mouth area and the rest of the face.

Teeth
A smile can hide a thousand lies, but just these three controls can accentuate the teeth.

	� Blue Gain: This control is used to color balance the teeth, making them whiter or yellower 
as desired.

	� Gamma: This manipulates a gamma curve allowing you to set how bright a smile the 
subject has.

	� Mask Softness: The softness of the blend between the teeth and the rest of the face.
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Blush
The parameters in this group let you modify the hue of the blush region of a subject’s cheek, 
letting you correct an unwise makeup choice, or push a subject’s blush color around to add 
makeup that wasn’t there.

	� Hue: This slider lets you adjust the hue of the cheeks.
	� Saturation: This slider then lets you intensify or remove blush color.
	� Size: This slider lets you adjust the size of the blush area of the cheeks.

About Forehead, Cheeks, and Chin Retouching
The next three groups of controls borrow a technique from portrait painters, who’ve long taken 
advantage of the “traffic light” approach to rendering skin hues, that observes that foreheads 
are often a bit yellow, the middle of the face is usually a bit red, and chins can be a bit green. 
A combination of unequal sun exposure, capillary distribution, and follicle growth account for 
this, but the bottom line is that faces are seldom a single unified hue. This means that there may 
be a region of the face that would benefit from individual adjustment (cheeks that have gotten 
too much sun, for example). But it also means that when you allow a bit of hue variation into your 
face grade, you can achieve a more naturalistic result.  

A face graded with a single hue. A face graded with slight variation 
in the forehead, blush area, and chin.

TIP: For a variety of reasons, people are extremely sensitive to the hues of skin tone, so 
tiny variations that can be difficult to identify nevertheless have a significant impact on 
the resulting visuals. Unless you’re aiming to create a special effect, these controls are 
meant to be used sparingly.
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Forehead
As the name implies, adjusts color and texture on the forehead.

	� Hue and Saturation: These sliders let you adjust forehead color. 
	� Gamma: This manipulates a gamma curve allowing you to set how bright the forehead is.
	� Smooth: This slider lets you apply a specific smoothing operation to the forehead to 

ameliorate wrinkles and worry-lines.

Cheeks
Simple color adjustment controls affecting the entire cheek area and not just the blush area.

Hue and Saturation: These sliders let you adjust the color of the cheek, eye, and nose area.

Chin
Simple color adjustment controls over the chin of the face.

Hue and Saturation: These sliders let you adjust the color of the chin, running up alongside 
the sides of the face (the beard area).

Film Look Creator (Studio Version Only)
The Film Look Creator gives you the ability to easily alter both the color and physical properties 
of an image to mimic motion picture film stock in a single Resolve effect. This effect is not 
focused on emulating a specific manufacturer’s film stock, rather it creates a base “Blackmagic” 
film look, that can be manipulated in a variety of creative ways. The Film Look Creator alters 
contrast, saturation, hue, and exposure of an image. It also includes the tools you want to have for 
film emulation, including halation emulation, film gate, flicker, weave, vignetting, bloom, and more.

Many of the components of the Film Look Creator have specific counterparts in the Resolve 
FX library. However, the Film Look Creator combines these film look tools into a single Resolve 
effect, with a greatly simplified tool set. If you ever find you need more control over an aspect of 
the look, you can always disable the effect’s module and use a dedicated Resolve Effect in the 
node tree instead.

When this effect is applied, an underlying Blackmagic film look is automatically set first. This 
film look is driven by over 60 parameters that you get with the plugin active (and all effects off). 
These parameters are fine tuned and “baked in” to the Blackmagic film stock. But while these 
can’t be adjusted, there are additional controls on the top area of the plugin that you can use to 
refine and create unique looks.

The Film Look Creator is designed for scene referred workflows and will work with any camera 
source and output display. When using either Resolve Color Management or ACES, this happens 
automatically because the plugin uses the timeline color space for input and output by default. 
The plugin also works for manually display referred timelines (such as DaVinci YRGB) as well, but 
then the user must manually choose the transform of the source footage and choose the display 
transform, which you can do within the plugin in the Color Space Overrides section.
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The original video 

Film Look Creator Bleach Bypass Super 16mm version

Main Controls
These controls create the foundation of this effect. 

	� Presets: Automatically sets all controls for a desired preset look. “Default No Effects” turns 
on the Blackmagic Film Look but disables all the additional effects below.

	� Color Blend: Allows mixing the underlying color look and any changes made to other color 
settings and split tone controls.

	� Effects Blend: The master control to adjust the strength of the spatial effects below. 0% is 
the effects completely off, and 100% is the full output of the Film Look Creator.

	� 3D LUT Compatible: Checking this box will remove spatial effect options which aren’t 
represented in a 3D LUT. This allows you to export your custom film look to other programs 
and camera hardware via a LUT. 
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Color Space Overrides
These controls allow you to change the input and output gammas and color spaces of the effect 
if you need to configure them manually for a display referred workflow. Please note that no tone 
mapping is applied if you change these. The default is “Use timeline,” which will match the color 
spaces you’ve selected in the Color Management section of the Project Settings.

	� Input Color Space: Sets the input color space; choose one from the drop-down menu.
	� Input Gamma: Sets the input gamma; choose one from the drop-down menu.
	� Output Color Space: Sets the output color space; choose one from the drop-down menu.
	� Output Gamma: Sets the output gamma; choose one from the drop-down menu.
	� Output White Point: Sets the display white point. For creative purposes, you can choose 

one from the drop-down menu. D65 is the default white point. 

Color Settings
These controls allow you to change the color information for the film look. These effects 
will be passed in a 3D LUT. 

	� Exposure: A photometric control that adjusts the exposure in stops (+/- 5).
	� Contrast: Adjusts the overall S-curve transfer function to add or remove contrast from the shot. 
	� Highlights: Adjusts the roll-off at the top of the S-curve, allowing you to reign in or expand 

the brightest areas of the shot.
	� Fade: Adjusts the roll-off at the bottom of the S-curve, allowing you to reign in or expand the 

darkest areas of the shot.
	� White Balance: This control uses chromatic adaptation to mimic what the source footage 

might look like if it were shot under different lighting conditions. Adjusted in degrees Kelvin.
	� Tint: Lets you adjust the green/magenta balance of the clip for balancing footage shot under 

limited spectrum lighting, such as fluorescent or sodium vapor streetlights.
	� Skin Bias: Lets you adjust the skin tones of the image. From -1 (warmer, darker, more 

saturated) to +1 (rosy, brighter, and less saturated). This can also be useful if you, for example, 
push tint in one direction, and then use Skin Bias to balance out the image.

	� Subtractive Sat: Allows adjusting overall image saturation in a way that more closely 
resembles a subtractive method.

	� Richness: Affects already more saturated areas, applying subtractive saturation to just those 
regions. Can be useful for adding depth and richness or pulling back a bit on more saturated areas.

	� Bleach Bypass: Simulates this well-known look by adding a desaturated, higher contrast 
version of the image onto itself.

Split Tone
These controls add color to shadows and highlights using an opposing hue angle. For example, 
adding orange to the highlights and teal to the shadows to get a more modern cinematic look. 
These effects will be passed in a 3D LUT.

	� Enable Split Tone: Turns this effect on or off.
	� Amount: The intensity of the split tone. This value must be greater than 0 to see an effect.
	� Hue Angle: This slider adjusts what complimentary hues are applied to the shadows 

and highlights.
	� Pivot: This control sets where the hue transition occurs in luma. Set to its extreme of 

0.000 or 1.0000, the pivot lets you apply a single tint to the shadows or highlight.
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Vignette
These controls are simplified window for adding a vignette to the shot. For more detailed control 
you could disable this setting and use the Vignette effect instead.

	� Enable Vignette: Turns the vignette on or off.
	� Amount: Sets the intensity of the darkened areas of the vignette.
	� Size: Sets how much the vignette reaches into the frame.

Halation
These controls are a simplified way of adding soft glows to the edges of the subjects in your 
frame to mimic this characteristic of motion picture film. If you want more control, you can disable 
this setting and use the Halation effect instead. 

	� Enable Halation: Turns the halation effect on or off.
	� Amount: Lets you set the intensity of the halation.
	� Radius: Lets you set the spread size of the glow from the edges.
	� Hue: Lets you tint the glow a selected color.

Bloom
These controls lets you introduce a subtle glow around the edges of highlights.

	� Enable Bloom: Turns the Bloom effect on or off.
	� Amount: Lets you set the intensity of the bloom.
	� Radius: Lets you set the spread size of the bloom from the edges

Grain
These controls are a simplified set of tools to emulate the grain patterns found on motion picture 
film. For more detailed control you can disable this setting and use the Film Grain effect instead.

	� Enable Grain: Turns the grain pattern on or off.
	� Preset: Provides some starting points for grain, based on film stock standards.
	� Amount: Determines the amount of grain in the image.
	� Size: Determines the size of the grain in the image.
	� Softness: Determines how crisp the individual grains are.
	� Saturation: Adds color to the grain. 0 is monochromatic.
	� Image Defocus: Affects the overall resolution of the image, defocusing more as you reduce 

the control towards 0. At 1.000 the resolution is untouched. This control does not affect 
the grain.
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Flicker
These controls add a gentle pulse to the image exposure, mimicking the flicker of motion picture 
projection. For more detailed controls you can disable this setting and use the Flicker Addition 
effect instead.

	� Enable Flicker: Turns the flicker effect on or off.
	� Amount: Sets how much flicker to add to the image. Low settings will be barely visible, while 

high settings can be useful for more extreme looks like the Nostalgic preset. 
	� Rate: The rate at which the flicker pulses.

Gate Weave
These controls mimic the slight horizontal and vertical shift of the image as the film is 
mechanically pulled through the camera’s gate.

	� Enable Gate Weave: Turns the Gate Weave on or off.
	� Amount: Determines the amount of motion to the weave.
	� Rate: The rate at which the weave moves.

Film Gate
These controls will add blanking to the edges of the image to mimic film projection or telecine 
alignment controls.

	� Enable Film Gate: Turns the Film Gate on or off.
	� Preset: Select an aspect ratio from different common film standards.
	� Ratio H/V: You can set a custom ratio for the image here.
	� Enable Curvature: Turning this on slightly rounds the corners of the image to mimic how the 

shape of an actual film frame is exposed.
	� Padding: This will zoom the image in and out of the blanking, allowing you to see the entire 

exposed “frame” of film, if desired. Similar to a telecine control.

Improved Blur Quality for  
Resolve FX Radial and Zoom Blurs
DaVinci Resolve 19 has added a quality setting for Radial and Zoom blurs. The options are Faster, 
Better, and Enhanced. The new Enhanced setting is designed to be used for sharp patterns in 
high resolutions. Unless you have these artificial patterns in your image, it is recommended to 
use the Better mode, as the Enhanced mode is much slower and will not improve the blur quality 
in these cases.
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Fairlight
DaVinci Resolve 19 offers the following new features and enhancements for Fairlight.

Ambisonics (Studio Version Only)

Overview
DaVinci Resolve Fairlight now fully supports Ambisonic immersive audio. 

	� Ambisonic tracks and busses handle all parameters and support pre- and post-fader sends 
and directs between channel-based and ambisonic formats. 

	� Mixing, metering, and monitoring workflows are fully Ambisonics aware, offering additional 
controls and metering information. 

	� Third-party audio effects (channel-based and Ambisonics-compatible) can be added to 
Ambisonics tracks and busses. This allows seamless adoption of workflows in new and 
existing Fairlight projects.

	� A new 3D pan view, including new azimuth, elevation, and distance controls, as well as 3D 
presets, continuous rotation, and multiple 3D view perspectives allows for easy switching 
between 2D and 3D views for channel-based or spherical panning. The new controls and 
presets are also available in the Space View Scope window.

What is Ambisonics?
Ambisonics is a full-sphere immersive surround audio format that allows representation of sounds 
in the horizontal plane as well as above and below the listener.

Ambisonics differs from most multichannel surround formats as its transmission channels don’t 
carry speaker signals. Instead, they represent the entire sound field, which can then be decoded 
to particular speaker setups.

Since Ambisonics can accurately represent the location of sound direction in space, mixing in 
this format can deliver benefits of producing a single mix for multiple output speaker formats, 
since the sound is placed as accurately as possible within the listening space for the chosen 
speaker setup. You can also “fold down” a full spherical mix to horizontal space-only.

In addition to standard surround formats like 5.1, 7.1.4, etc., output speaker formats can include 
large individual speaker arrays (as might be found in a theme park or art installation), since 
Ambisonics does its best job at accurately representing source directions and decoding to a 
particular target format.

Via a suitable output speaker representation (including binaural for headphones), Ambisonics 
offers a flexible, single method for producing multichannel immersive audio and has found utility 
in the gaming, VR, and sound installation space. 

DaVinci Resolve Fairlight offers full Ambisonic support, including spherical panning, Ambisonic 
bussing, effects plugins, and up/downmixing, with accuracy of up to 5th order HOA (high order 
Ambisonics) and binaural decoding to headphones.
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Ambisonic “Orders”
Ambisonics offers a selection of “orders,” which refers to the mathematical precision used to 
represent the sound field. The simplest is 1st order, which uses 4 discrete channels to represent 
the sound field; Ambisonics supports higher orders, most commonly up to 7th order. 

As you increase precision via a higher order, more audio streams and a larger amount of 
processing power is required. Fairlight supports up to 5th order Ambisonics, which requires 
36 discrete channels to represent the signal. But you can usually get excellent results using 
3rd order, which uses 16 channels. 

Capturing Natural Ambisonic Sound Recordings
Specialized tetrahedral microphones can be used to capture natural spherical ambisonic audio, 
allowing a striking degree of realism. These mics have 5 precisely aligned capsules, and their 
output signal is a 4 channel “adaptive” container recording that can be flexibly placed in 
Ambisonic space in your mix.

Working With Ambisonics
Enabling Ambisonics
Open the main Resolve Preferences dialog, choose Video and Audio I/O > Immersive Audio, 
and enable the Ambisonics checkbox. 

Setting up Your Ambisonic Mix
	� Determine what Ambisonic order you want to work in. For precise positioning, 

higher order is best; 3rd order can be a good choice. 
	� Create Ambisonic busses and assign your source tracks or other busses to them.
	� Create Ambisonic effects sends or returns as required, or position mono, stereo, or 

multichannel returns in Ambisonic space.
	� Position your sources in Ambisonic space via the 2D or 3D spherical panners on 

each channel.
	� Monitor your mix via a chosen decode speaker format for your bus or binaural 

(to decode to headphones). 
	� Choose your decode format in the Monitor section drop-down menu next to the speaker 

output level control.  
	� A decoder is automatically placed into the monitoring path for the 

currently chosen configuration.

Choosing Output Monitor format from an Ambisonic bus
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Positioning Source Sounds in an Ambisonic Mix
As with other immersive audio formats, you can use mono or stereo source signals and position 
them freely in the spherical sound field. Plugin processing like dynamics, EQ, or reverbs can also 
be be used that are Ambisonics-native.

Bussing Ambisonic Busses to Other Ambisonic Busses
You can assign Ambisonic busses to other Ambisonic busses, including differing orders. Any 
required up- or down-mixing is automatically handled by the Fairlight engine and FlexBus.

Parallel Ambisonic and Channel-based Workflows
You can freely create Ambisonic mixes and channel-based mixes in the same timeline and render 
multiple outputs that consist of the different formats simultaneously.

Ambisonic File Support
Ambisonic files in WAV, BWAV or .caf (including 1OA AMB and AmbiX format) are supported, and 
placing files on a timeline (or creating a new timeline referring that media) from the Media Pool 
will create the appropriate track type required for the file (order and number of streams).

Monitor Bus Assignment
There are 2 drop-down menus in the monitor assignment section below the docked Fairlight 
viewer; one for the bus source and one for the output format assignment. 

Bus Source drop-down in Monitor Assignment area

Fairlight Effects and Ambisonics
Most Fairlight effects, including channel dynamics and EQ, dynamics processors like Multiband 
Compressor, Limiter, or Reverb are all Ambisonics native, that is, the processing is multichannel 
and Ambisonics-aware.

AU/VST Ambisonic Effects
Compatible third-party AU and VST Ambisonic effects can be freely used on Ambisonic tracks 
or busses. 

Ambisonic Metering
Bargraph Metering
Ambisonic metering signals in Fairlight are represented by a single, composite bargraph meter 
for mixer, track header, and meter panel meters as they generally don’t correlate to specific 
speaker positions or levels that we would track visually to determine what is happening with the 
Ambisonic signal. Instead, we can look at the overall energy in the single channel meter and use 
more specialized metering tools to visualize a “heat map” of where the source is positioned in 
spherical space. You can optionally choose to view the Ambisonic signals as discrete, separate 
bus streams by choosing Fairlight > Immersive Audio > Discrete Ambisonics Channel Metering.
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Ambisonics default metering Discrete Channel metering

Fairlight FX Metering
A resizable Fairlight FX Ambisonic meter can be instantiated on any Ambisonic track or bus by 
choosing the Effects drop-down in the Mixer channel > Ambisonics > Fairlight FX > Ambisonic 
Meter. This meter presents a graphic display of your sound field. You can choose to monitor 
“power” or  intensity or a “sonar” style map via the 3 dot options menu.

Fairlight FX Ambisonic Channel meter
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Metering in Space View Scope
You can enable the Ambisonics metering by enabling the checkbox in the lower left-hand corner 
of the Space View Scope (Fairlight > Immersive Audio > Space View Scope…). This option is 
available whenever one or more high-order Ambisonics sources are present in the Timeline. 

There are different projection views available via icons in the lower left area of the Space 
View Scope’s frame; you can choose one that is optimal for your application when viewing 
Ambisonic sources. 

Space View Scope Projection view with Ambisonics Metering enabled

Meter Overlay in Video Viewer
An Ambisonics meter overlay can be seen in the Fairlight Video Viewer by enabling the option in 
the Tool menu on the Viewer. When docked, the menu floats on the video on the lower left; when 
undocked, it appears on the upper left of the window’s menu bar. When working with 3D, you 
can choose 360 Viewer Mapping for working with 360 LatLong video sources, allowing you to 
track panning in a “flat” video projection of 3D space. 

Ambisonics Meter Overlay options
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Ambisonic Panning
You can freely switch between use of 2D and spherical panning. Spherical panning allows you 
to position your source anywhere in the sound field, including up or down. Spherical panning is 
based  on Azimuth, Elevation, and Distance.

3D Spherical Panner showing Rear Projection

Rendering Output Files
Ambisonic format mix output files can be rendered from the Deliver page. Ambisonic files are 
multichannel adaptive containers with the number of streams dictated by the Ambisonic order of 
your output (e.g., 1OA, 2OA, etc.). You can also render a an output file that is up- or down-mixed 
for your desired speaker output configuration (e.g., 7.1.4).

IntelliTrack-Powered Audio 
Panning to Video (Studio Version Only)
Totally new and unique to DaVinci Resolve, now you can automatically track people or objects 
in the Fairlight viewer, generating pan automation data that matches object movement with the 
precision afforded by DaVinci Resolve’s state-of-the art object tracking engine. 

This can greatly accelerate creativity, saving loads of time and effort.
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	� To enable automatic tracking, ensure that the Toggle Automation switch is enabled above 
the  main Fairlight tools.

Toggle Automation Switch enabled

	� Choose “Display Tracker Controls” in the Viewer mini drop-down menu (lower left), enable 
the Auto button, and choose which pan controls you want to automate.

	� You can also choose to show numerical tracker coordinates via the mini-menu.  

Auto Tracking enabled and Left-Right Panning armed

	� Create a selection in the Timeline that you want to track over. 

NOTE: Auto tracking will not take place without a selection and the 
target track being selected.

	� Move the Automation View selector on the track header so that one of the pan data 
parameters you’ve write-enabled on the Viewer is in view.

	� Move the Auto Tracker object on top of the object that you want to track and press the 
Track button. 

Track button

	� After a few moments, automation data appears for the track pan parameter(s). You can edit 
the generated data like any other written automation curve.
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NOTE: If the track is more complex (e.g., a person who may be changing their position 
relative to the camera or may have moved out of frame), you may need to do your 
tracking in sections. You can select an area that wasn’t tracking well, move the tracker 
object into position, and track over the problem range to redo the track for that portion. 

The IntelliTrack panning the audio automatically as the jets fly through the frame

Simultaneous Auto Tracking of X-Y-Z Positional Information Not Yet Supported
You can perform an auto track with Left-Right and Up-Down at the same time, but at this time you 
can’t track distance (Front-Back) simultaneously using the same tracker object. 

Manual Tracking Using the Viewer
You can also manually track objects by deselecting AUTO. In Manual Tracking mode, the Tracker 
object changes into a simple crosshair. 

To do a manual pan track:

	� As with auto tracking above, ensure that the Toggle Automation switch is enabled above the 
main Fairlight tools.

	� Choose “Display Tracker Controls” in the Viewer mini drop-down menu (lower left), enable 
the Auto button, and choose which pan controls you want to automate. 
You can also choose to show numerical tracker coordinates via the mini-menu.

	� Select your target track, and set the Automation View selector on the track header so that 
one of the pan data parameters you’ve write-enabled on the Viewer is in view.

	� Position your tracker at the point where you want automation to start.
	� To write a keyframe at the current position in the video, option (Alt) click on the tracker 

object. A keyframe that corresponds to the position of the manual tracker in the video viewer 
is placed on the automation line for the selected track.

	� To add another positional panning keyframe, move to another point in your timeline, position 
your mouse cursor over the point in the video you want pan to, and option-click. The tracker 
object now jumps to that position, and a keyframe is written. 
DaVinci Resolve will smoothly vector between the keyframes as with any other automation 
curve data.

	� Continue to create keyframes at desired positions by navigating in your video and option-
clicking on the object you’re tracking at the point where you want to each keyframe to appear. 

	� To create a “bounding keyframe” (locking position that holds the automation line before 
moving to a new position), option-shift-click on a location. 
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Audio Effect Sidechaining
Fairlight now supports flexible sidechaining for any capable Fairlight FX and AU or VST plug-ins. 

What is Sidechaining?
Sidechaining allows a track or bus signal to control the response of another plugin (often on another 
audio track). This is most commonly used to control changes in a dynamics or level processor when 
being fed by another source but can be used with other plugins as well for creative effect.

An example of sidechain usage would be having a dialogue bus control the amount of level 
reduction or compression on background effects or music beds. Or when doing sound design, 
you might have a gate whose signal input is a steady low frequency rumble, which is being 
triggered to open by Foley footsteps fed into the sidechain input, so each step results in the low 
frequency rumble sound being triggered on and off by the footstep.

Sidechaining Controls
The Fairlight channel dynamics processor and the Limiter Fairlight FX plugin both support 
external sidechaining. The Fairlight channel dynamics processor has side chain controls in the 
right-bottom area of the compressor controls section, and the Limiter has them at the top of the 
plugin on the right. 

Sidechain Enable, Listen, and Source menu

Controls for AU and VST plugins are located at the top right of their floating user 
interface  windows.

AU and VST Sidechain controls are at the top of the window

Using Sidechaining
To use sidechaining:

	� In the target plugin, choose a sidechain source from the Source menu. The source can be 
any track or bus. Using a bus lets you have multiple source signals control the receiving 
plugin at once.

	� Enable the Sidechain signal input by clicking the Sidechain button.
	� You should now be able to adjust the controls on the plugin with the external Sidechain 

signal affecting the internal processing.
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Sidechain Listen
It can sometimes to be helpful to listen to the source signal coming into your plugin. The Listen 
button allows you to verify that the right signal (or any signal) is being “heard” by the sidechain 
input. Remember to turn off the Listen button when you’re done, or you won’t hear the correct 
signal on your track.

New Track FX Plugins 
Dialogue Separator, Music Remixer, and Ducker are all Track FX plugins due to their processing 
buffers. They reside in dedicated insert points after Voice Isolation and Dialogue Leveler in the 
TrackFX section of the Fairlight mixer.

Showing Track FX Plugins
By default, only Voice Isolation and Dialogue Leveler are shown to avoid clutter to the interface. 
To make the other Track FX visible, choose the options 3 dots menu on the right of the Fairlight 
mixer, make sure that Track FX section is checked on, and then choose which plugins you want 
to see with “Visible Track FX” submenu at the bottom.

The Visible Track FX listing in Fairlight Mixer’s Option menu

Dialogue Separator
The Dialogue Separator uses DaVinci Neural Engine AI to give you individual control over the level 
of dialogue, background sounds, and “ambience,” the reverberant field or ambient room sound.

The Dialogue Separator controls
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If you have a source file that contains a great roomy sound, but there is music in the background 
or crowd noises, you can rebalance so that the background sounds come down a bit or adjust 
the room sound down a bit for better intelligibility. 

Or you might have a situation where someone is moving closer to camera in a roomy 
environment. By adjusting and automating the balances, you could make the sound roomy to 
start with and get drier as it comes closer, all without affecting the background.

NOTE: Dialogue Separator is presently mono only, so if your source is stereo, you’d 
have split into dual mono and process two mono tracks separately.

Music Remixer (Studio Version Only)
The Music Remixer is a DaVinci Neural Engine AI-based effect. This TrackFX plugin uses AI to 
split music into individual basic stems: Vocals, Drums, Bass, Guitar, and “Other,” which means 
“everything else.” You can use the level controls to rebalance or remix the sources, or the mute 
buttons to make instant changes and bring parts in and out of your mix.

Music Remixer lets you creatively adjust a music track to suit your needs. For example, you might have 
a track where you need to remove the vocal or rearrange to allow for quieter moments or a build. 

The Music Remixer controls

The Mute buttons let you quickly bring sections in or out for your arrangements, and you can use 
automation to capture all of your changes.

Ducker
The Ducker Track FX plugin allows you to automatically lower the level of a track by using an external 
source signal – this is known as “ducking.” Most commonly ducking is used to have dialogue or 
VO automatically lower a music or sound effects bed, but it can be used in many creative ways. 
Set up correctly, your sources can often “mix themselves” and you can create very useful results.

The Ducker uses changes in level only to do its work; the audio is not compressed or limited. 
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The Ducker controls

To use the Ducker:
	� Choose the target track that you want to affect (the “destination” track), and open the Ducker.
	� Choose the Duck Source track or bus in the drop-down menu. 
	� This is the sound source you want to use to duck the level of the target track.
	� If you use a bus, you can use multiple sources to trigger changes in your ducked target track.
	� Play a bit of your sequence, and adjust the duck level and other controls to taste. 

Ducker Controls
	� Duck Amount: Controls the amount of ducking (lowering of level on the target track) in dB 

with a default of 2.7 dB. Most of the time, the amount will work best between 2 and 5 dB.
	� Lookahead: Controls the amount of lookahead time in milliseconds, with a default of 15ms. 

The lookahead allows the Ducker to start to lower the destination track before the source 
track is audible. The larger the value, the more the Ducker will “pre-anticipate” the source 
track. If you want to have the Ducker start to lower the sound before a line of dialogue or 
VO begins, you can experiment with higher values, but normally the default will produce 
good results.

	� Rise Time: The amount of time, in milliseconds, it takes for the Ducker to reach the amount 
of reduction specified by Duck Amount. The default is 10 ms. Most times, this value should 
be effective, but with high Duck Amount values and longer gaps in the source track’s signal, 
longer values may be useful.

	� Hold: Amount of time, in milliseconds, the Ducker will hold the level reduction set by Duck 
Amount before moving to the Recovery time phase. The default is 150 ms.

	� Recovery Time: Amount of time, in milliseconds, that the Ducker will take to recover from 
the Duck Amount (maximum level reduction) to no level reduction. The default is 750ms. 
Setting the Recovery Time properly can have a strong effect on whether the Ducker sounds 
“natural” or if it is distracting because level is changing too slower or quickly in response to 
the source track (e.g., dialogue). Experiment with your source material to find the best results.

Ducker Graph Display
The graph area shows a continuous representation of the level of the incoming waveform against 
the action of the Ducker, shown in yellow. The yellow line mainly stays where the Duck Level puts 
it; when the yellow line travels upwards, it means that the Ducker is lowering the level less, as it is 
affected by gaps in the Duck Source signal and the response of the various controls.
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Fairlight FX Improvements
Voice Isolation Updates
Voice Isolation works better on a wider variety of source signals, improves stereo performance, 
and features improved, more responsive buffering.

Dialogue Leveler Improvements
The Dialogue Leveler has been improved with faster cue up time.

Frequency Analyzer Plugin Updates
The Frequency Analyzer Fairlight FX plugin has an improved spectrum graph to match the new 
RTA display on the channel EQ, including fill, color, and response tweaks.

There’s also a switch added below the graph to change between “Spectrum” and “Waterfall” 
options as well as general improvements to the Waterfall display.

Track EQ Improvements
The track EQ now supports selectable slope filtering for high and low pass filters, up to 
24dB/octave. The EQ display now includes a RTA frequency spectrum for instant previews of 
parameter changes.

Panner Dialogs Updates
In panner dialogs, the listener perspective can be flexibly adjusted, allowing you to place yourself 
as listener from the side, above, or any angle. With Ambisonics workflows, head/torso and 
speaker projections assist in visualizing the listening environment.

Fairlight Dynamics now supports flexible sidechain routing from any bus, sidechain on/off, and 
side chain listen.

Other New Features in Fairlight

Multiple Automation Improvements
Several automation workflow areas have been improved.

Clear All Track Automation 
You can now clear all automation for a track. Select the track header, right-click, and navigate 
to “Clear Track Automation.” A dialog box appears asking if you want to clear the automation 
entirely (“Reset”) or leave with the controls set to where they are presently (“Hold”).

Other Automation Improvements
	� Plugins and parameters are now listed in automation menus in the same order as the inserts. 
	� New track header tool tips provide additional feedback on which parameter is being viewed 

from which insert slot.
	� Keyframe handling has been vastly improved in anchoring, initial keyframe handling, bi-state 

level control keyframes, and other areas.
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Snap To Head/Tail
You can now snap the head or tail of a clip to the playhead while in Focus mode, using the 
Hand tool (bottom portion of the track). This allows you to quickly line up events (e.g., elements 
of an explosion).

When snapping to head or tail:
	� Only one clip can be snapped at a time.
	� Clips can only snap within their own track.
	� Range/clip selections (head) count as snap targets.
	� A snapped clip will overwrite any clip content at target (or top layer in layered mode).
	� “Automation follows edit” works with snapping.

NOTE: If the snap target location is offscreen, snapping will still work.

To snap to head:
	� Ensure you’re in Focus mode, then place your playhead at the desired location to snap to.
	� Hold down Command-Option and click on the clip you want to have snap.
	� The head of the clip will now snap to the playhead.

To snap to tail:
	� Ensure you’re in Focus mode, then place your playhead at the desired location to snap to.
	� Hold down Command-Option-Control and click on the clip you want to have snap.
	� The tail of the clip will now snap to the playhead.

Exclusive Solo Mode 
Exclusive solo mode allows you to solo only one item at a time; pressing another track’s solo 
button will solo only that track, un-soloing any others. This can be very useful when comparing 
sonic treatments between two or more tracks. Exclusive solo by navigating to Fairlight > 
Exclusive Solo.

Group Panning
Track groups now supports panning across group members. To enable Group panning, check 
the “Panning” checkbox in the Groups setup dialog. 

Group Panning can be enabled in the Create Group dialog
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Smart Zoom
This powerful feature allows you to zoom in on your selection (or the entire Timeline) with a 
single click, and enlarge track height to take up the full screen area of the Timeline, centering 
your selection on the screen. Then, when you’re done, choose the same command to toggle and 
zoom back to what you started with. It’s like having a magnifying glass for your selection with the 
ability to move back to the “zoomed out” focus. 

Initial selection before Smart Zoom 

Selection after Smart Zoom

The selection includes any tracks and the time range selection, including Focus mode.

Smart Zoom is mapped by default to Command-option-E but can be remapped in the 
Keyboard Customization dialog. 
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LTC and MTC Chase Sync
DaVinci Resolve can now chase and sync timecode via LTC from any audio input on your audio 
interface, via MIDI Time Code (MTC), configurable via Fairlight > Remote Control.

NOTE: At the present time, the LTC reader input of the Fairlight Audio Interface is not 
operational; this should be addressed during beta.

Automatic Input Patching on Record Arm
Arming a track for record will now patch the default input on your audio interface automatically, 
so you’re ready to record. Initially, this will be the first input in your system (set up in Preferences 
under Video and Audio I/O in the Audio I/O panel). This also works with system audio on your 
computer (provided it’s set up in your computer’s operating system correctly). The default input 
on macOS is set by System Preferences.

Miscellaneous New Features
Dynamic Delay Compensation Now Supported With AU Plugins
If an AU plugin has different processing delay values that change, Fairlight will now properly 
update delay compensation.

Fairlight Console Loop Behavior Update
Fairlight consoles now follow the loop icon status with no requirement for Play Around/To to 
commands to be used. 

Support for Third-Party Auto Conform Workflows
DaVinci Resolve now works with select third-party auto conform applications, allowing round trip 
of data and reconform to occur seamlessly.

Dolby Atmos Composition Fade Support (Studio Version Only)
Basic fades can now be created on Dolby Atmos master files that are placed on a timeline as a 
clip and edited. However, complex fades and batch fades are not supported.

Support for Sony 360RA Walkmix  
Audio Formats and Plugin (Studio Version Only)

Improved ADM and Vivid Audio  
with MPEG-H SDK 2.75 (Studio Version Only)
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